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Safety Symbol Legend

Indicates a procedure, condition, or statement that, if not
strictly observed, could result in personal injury or death.

Indicates a procedure, condition, or statement that, if not
strictly observed, could result in damage to or destruction of
equipment.

Indicates a procedure, condition, or statement that should be
strictly followed in order to optimize these applications.

Note  Indicates an essential or important procedure, condition, or statement.
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This equipment contains a potential hazard of electric shock
or burn. Only personnel who are adequately trained and
thoroughly familiar with the equipment and the instructions
should install, operate, or maintain this equipment.

Isolation of test equipment from the equipment under test
presents potential electrical hazards. If the test equipment
cannot be grounded to the equipment under test, the test
equipment’s case must be shielded to prevent contact by
personnel.

To minimize hazard of electrical shock or burn, approved
grounding practices and procedures must be strictly followed.

To prevent personal injury or equipment damage caused by
equipment malfunction, only adequately trained personnel
should modify any programmable machine.
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Chapter 1   Overview

Introduction
For a list of the drives that may
be included in an LV lineup,
refer to the “Equipment
Covered” section of this
document.

This document is an installation and startup guide for Innovation Series™ Low
Voltage (LV) ac drive lineups. It assumes the following:

• All receiving, handling, and storage procedures were strictly followed, as
defined in document GEI-100256.

• You are ready to move the drive(s) to the installation site.

• The installation site was previously prepared and cables run per GE
specifications, and all necessary system parts are at onhand at the site.

Additionally, these instructions require that the user:

• Be adequately trained to thoroughly understand and strictly follow all safety
procedures necessary for working with and around high voltages.

• Know the physical and electrical requirements of installing high voltage
equipment.

• Understand the theory of drive operation.

• Be experienced in using the Innovation Series drive configuration software (the
GE Control System Toolbox).

• Understand the structure and conventions of this document in order to follow the
instructions exactly as required.

This first chapter provides an overview of how to use this document correctly, as
follows:

Section Page

How to Use This Document..................................................................................... 1-2
Structure of the Document................................................................................ 1-2
Text Conventions.............................................................................................. 1-2

How to Get Help ...................................................................................................... 1-2
Equipment Covered ................................................................................................. 1-4
Related Documents .................................................................................................. 1-5

Document Distribution ..................................................................................... 1-5
Acronyms and Abbreviations................................................................................... 1-6

The remainder of the document is organized in the order required for installing and
starting the drive lineup (see How to Use This Document).
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How to Use This Document

Structure of the Document

GE recommends that a detailed
installation log is maintained
for each drive as these
installation and startup steps
are completed.

Sections of related procedures are presented in the order that they should be
followed (see Figure 1-1).

Appendices provide reference information, as follows:

A, Understanding Equipment Drawings

B, Cable Separation and Routing

C, Printed Wiring Board Reference

D, Pre-Startup Checklist

E, Configuring an Innovation Series Drive

For an exact outline of the document’s organization, refer to the Table of Contents.

Text Conventions
Convention Meaning

½ A procedure follows.

Numbered list Procedural steps to be followed in order (for example, 1, 2, 3).

Alphabetized list Procedural substeps (of numbered steps) to be followed in
order (for example, a, b, c).

Bulleted (•) list Related items or procedures, but order does not matter.

w A procedure with only one step.

Boxed (�) list A checklist.

Arial Bold When describing software, indicates the actual command or
option that is chosen from a menu or dialog box.

Monospace Represents examples of screen text or words and characters
that are typed in a text box or at the command prompt.

How to Get Help
If help is needed beyond the instructions provided in the drive system
documentation, contact GE as follows:

“+” indicates the international
access code required when
calling from outside the USA.

GE Industrial Systems
Product Service Engineering
1501 Roanoke Blvd.
Salem, VA  24153-6492  USA

Phone: + 1 800 533 5885
Fax: + 1 540 387 8606
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Move drive to
installation site &
mount it

Chapter 2,
Handling and Mounting
Guidelines

Connect cable & I/O Chapter 3,
Cabling and Connections

Mount and install
external devices

Chapter 4,
Device Installation

Start
Procedures

Installation site ready;
drawings & documents
onhand; all site parts present

Apply power, start
toolbox, run wizards

Chapter 6,
Startup and Commissioning

End of
Procedures

Verify correct
functioning of
connected devices
(power, I/O)

Chapter 5
Pre-Powerup Installation
Checks
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Figure 1-1.  Structure of Document for Use in Installation and Startup
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Equipment Covered
In this document, the term
“drive” includes both sources
and inverters.

An ac drive lineup is a combination of a source and one or more inverters that
generate ac power to a motor at a required frequency and current. The output
requirement determines the lineup structure.

The LV drives used in a lineup include common bus non-regenerative sources,
common bus regenerative sources, and dc-fed inverters available in the following
frame sizes:

Frame*
Size Inverter

Non-Regen.
Source

Regen.
Source

    65 á
    92 á
  125 á
  180 á
  250 á
  375 á á
  620 á á á
1000 á á á
1800 á á á

  *Frame size indicates the approximate current rating.

In firmware, the pattern (product) number identifies the drive application, as follows:

Pattern Drive Application

ACDCF-G ac drive, dc-fed inverter, general industry applications

ACDCF-S ac drive, dc-fed inverter, system applications

ACDCF-V ac drive, dc-fed inverter, V/Hz applications

ACCBN-A ac drive, common bus non-regenerative source, version A

For additional information
about the drive pattern, refer
to the "Intelligent Part Number"
section of Appendix A.

ACCBR-A ac drive, common bus regenerative source, version A
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Related Documents
If needed for supplementary information, refer to the following Innovation Series
product documents, as applicable:

Subject Document Content

LV drives:

Elementary drawings GEH-6389 Standard electrical wiring schematics for all LV drive frames

Standard layout and outline
drawings

GEH-6390 Standard drive panel layouts showing internal component locations, and
standard outlines showing dimensions and weights, for all frames

User’s guide GEH-6392 Functional description, technical data, customer I/O connections, keypad
(DDI) overview; maintenance; component replacement

Firmware application reference
and troubleshooting:

ACDCF-G

ACDCF-S

ACDCF-V

ACCBN-A

ACCBR-A

GEH-6393

GEH-6394

GEH-6395

GEH-6396

GEH-6397

Description of faults codes, firmware functions, associated parameters,
wizards, and signal mapping for:

dc-fed inverters, general industry applications

dc-fed inverters, system applications

dc-fed inverters, V/Hz applications

common bus non-regenerative sources

common bus regenerative sources

Printed wiring boards See
Appendix C

Board function within the drive, I/O, configuration requirements, and
replacement

Related or integral products:

Installation guidance for
Innovation Series equipment

GEH-6380 Drawing content and distribution options; equipment cabling
requirements; installation service options

Control system toolbox GEH-6401 How to use the control system toolbox screens and options for
configuring an Innovation Series drive

Trend Recorder GEH-6408 How to use the Trend Recorder feature of the control system toolbox,
including how to record graphical views of drive signals

Receiving, handling, and
storage

GEI-100256 Procedures, precautions, and environmental requirements for receiving
the drive from the shipper and storing it before installation

Document Distribution

GE Industrial Systems supplies product documents to its customers to support the
equipment provided for each requisition. The contract documents define the terms of
the document distribution.

If provided (per contract), the following documents contain requisition information
about the drive system.

• Requisition drawings, including outlines, layouts, and elementary diagrams

• Renewal Parts listing

Note  If differences exist between the general product documentation and the
requisition documentation, the requisition documentation should be considered the
more exact representation of your equipment or system configuration.
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Acronyms and Abbreviations

A ampere(s) LED light-emitting diode

ac alternating current level H high-level signal

ACL application control layer level H(S) high-level signal, special handling

ACOM analog common level L low-level signal

ADF auxiliary device feeder level M medium-level signal

ADS auxiliary device (circuit) switch level P power signal

ATBA IS200ATBA Application Terminal Board level P(S) power signal, special handling

CCOM control common m meter(s)

CPT control power transformer max. maximum

dc direct current NEC National Electrical Code

DCOM digital common n-m Newton-meter (torque)

DDI Drive diagnostic interface (keypad) OSHA occupation and safety health act.

ft foot, feet PC personal computer

ft-lbs foot-pounds (torque) PLC programmable logic controller

ft/min feet per minute PSI pounds per square inch

GE General Electric Company PVC polyvinylchloride

IGBT insulated gate bipolar transistor PWM pulse-width modulated

in. inch(es) SCR silicon-controlled rectifier

in-lbs inch-pounds (torque) RAPA IS200RAPA Control Rack Power
Supply board

I/O input and output RTDs resistance thermal devices

IPN intelligent part number SHCOM shield common

kg kilograms V ac volts ac (alternating current)

LAN local area network V dc volts dc (direct current)
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Chapter 2   Handling and Mounting
Guidelines

Introduction
GE document GEI-100256
provides receiving and storage
guidelines.

The handling and mounting requirements for the LV drives may vary according to
the drive frame size and the lineup combination. This chapter provides general
guidelines for moving the drives to the installation site, and then mounting them.
The requisition drawings or standard outline and layout drawings in document
GEH-6390 provide specific information for each drive system and are a required
supplement to this document. This chapter is organized as follows:

Section Page

Drive Handling Procedures...................................................................................... 2-1
Lifting ............................................................................................................... 2-2
Moving.............................................................................................................. 2-3
Unpacking......................................................................................................... 2-3

Mounting.................................................................................................................. 2-4
Securing Lineup Sections Together .................................................................. 2-4
Securing the Drive Lineup to the Floor ............................................................ 2-7

Drive Handling Procedures

Shock or stress caused by rough handling or improper lifting
and moving can damage the equipment. Be sure to follow the
guidelines provided in this chapter.

The shipped equipment may
consist of either a single drive
or multiple drives secured
together in a lineup, typically
not exceeding 15 ft in length.

GE recommends that you do not completely unpack the equipment until it has been
moved as near as possible to its permanent location. This practice helps ensure that
loose parts remain with the drive(s). Additionally, the shipping enclosure helps
protect the equipment during storage.

Before lifting and moving the drive(s), always refer to the equipment outline
drawings. Become familiar with the designated lift points and the stress points, and
any specified handling instructions.

While lifting and moving the drive(s), be sure to follow the suggested methods in
this chapter for handling the equipment, along with normal handling precautions.
Additionally, it is important to observe any instructions that may be printed on or
attached to the equipment container or wrapping.
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Lifting
Lifting beams are attached
across the top of the drive(s) at
the factory.

• Make sure that the lifting equipment is suitable for the configuration and weight
of the drive(s). Refer to the Figures 2-4 through 2-10.

• Observe the center-of-gravity.

• Make sure that the lifting beams are tightly secured to the drive(s).

• Use at least four hooks for lifting (see Figure 2-1).

• The lift cables should be at an angle greater than 45 degrees from the horizontal.
Use spreader bars or similar equipment to ensure this angle.

• Lift the drive(s) in a slow and steady manner to an acceptable clearance height.

• Check for any flexing of the equipment. If noticed, lower the lineup and
re-position the cables.

Do not lift and move the drive(s) using equipment that applies
pressure from below, such as a forklift. Doing so could damage
the drive frame. If a crane is not available for lifting, contact
GE for guidelines on using other methods.

Angle between lifting
cables and cabinet.

Covers over extra lift beam
openings (installed at  the
factory.) Do not use these
holes for lifting.

Four lift beam openings.
Use for lifting.

> 45°

Figure 2-1.  Proper Lifting Method
for Drive Lineup
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Moving
• When using a crane, be sure that motions are slow and smooth so that the

equipment does not swing.

• If using other moving devices, such as rollers:

− Be sure to place the rollers at the shipping splits and at the corners to reduce
potential stress.

− Roll only on the shipping pallets that are attached to the cabinets when
shipped from the factory.

• Do not move with a forklift, since the weight of the drive against the forklift
tines would put damaging pressure on the drive frame.

• Make sure that all doors are closed and latched.

Unpacking
Recommended:  Do not com-
pletely unpack the equipment
until it is placed as near as pos-
sible to its permanent location.

• If the equipment has been exposed to low temperatures for an extended period,
do not unpack it until it has reached room temperature (location where drive will
be mounted).

• Use standard unpacking tools, including a nail puller.

• When unpacking, check the contents of each case against the packing list.
Report any shortage to GE.

• Carefully remove the packaging and move the equipment from its container, still
observing all lifting and handling guidelines.

• While unpacking, inspect for damage that may not have been detected at the
time of receipt.

• Wipe off any particles of packing materials or foreign substances that may be
lodged in or between the parts.

• Small parts (such as bolts and screws) are packed in special containers to keep
them together, but may become separated. For this reason, carefully inspect the
packing material for loose parts before discarding it.

Document and report equip-
ment damage to GE.

½ Do the following if equipment damage is discovered while unpacking

1. Stop unpacking immediately and report this finding to the carrier (transportation
company).

2. Photograph the damage (photographs may be needed later in processing the
claim).

3. File a claim with the carrier.

4. Contact the local service office of GE Industrial Systems for assistance.

5. When identifying missing or damaged parts, be sure to includethe following
information (refer to Appendix A):

• Serial number

• Part (model) number

• Drive code

• GE requisition number

• Case number
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Mounting
GE document GEH-6390
contains the outline drawings
for each drive frame size.

Figures 2-4 through 2-10 are simplified outline drawings that provide the following
installation data:

• Drive dimensions

• Door clearance

• Bolt hole location

• Drive weight

• Heat loss

• Airflow requirements

These figures reference the more detailed individual outline drawings available for
each frame size in GEH-6390.

The requisition outline draw-
ings show specific lineup and
installation details.

½ Along with the information shown on the outline drawings, use the
following mounting guidelines

• The mounting surface should be smooth and level to prevent door misalignment.

• Position the drive to permit heat radiation from all surfaces and proper ventila-
tion (cooling air).

• Provide front clearance of at least the width of the enclosure door so that the
door can be fully opened for easy access.

• If lifting beams are removed after positioning the equipment, then lifting beam
hardware must be replaced in the holes in the enclosure top and re-tightened.

Securing Lineup Sections Together
Drives within a shipping split
have been secured together at
the factory.

Lineups are typically shipped in sections of 15 ft or less, called shipping splits.
During the mounting process, the installer must attach these shipping splits together
in three primary locations (refer to Figure 2-2):

• Drive cabinets, using tie brackets and plates

• Dc through-bus, using power bus tie splices (connectors)

• Protective ground, using ground tie plates

The required hardware for the connections are shipped in boxes placed inside the
drive cabinets.

Connecting the Cabinets
This connection uses two tie brackets and four tie plates for each shipping split. The
tie brackets mount to cabinet framework, one in front and one in the rear, approxi-
mately midway up the cabinet. The four case tie plates mount at the floor and the
roof of the cabinet.
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Connecting the DC Through-Bus
This connection uses two flexible dc bus tie splices for each lineup split. The bus tie
splices are bolted directly to the integral dc through-bus.

½ When making this connection

• Inspect the rubber sleeve for insulation damage before installing it.

• Tighten bus bolts to the appropriate torque before energizing the drive (see
Table 2-1).

Connecting the Protective Ground
A metal ground tie plate is supplied to connect the protective ground from one cabi-
net to the adjoining cabinet.

This connection must be complete to ensure proper grounding
of the equipment.

Table 2-2.  Torque Values for Screw/Bolt Connections

Torque
Screw/Bolt Connection Fastener

Size in-lbs ft-lbs n-m

Capacitor:

Terminal connections M16     30     3     3

Nylon nut Special     70     6     8

IGBTs:

Mounting screws to heatpipe M6     45     4     5

Captive screws attaching interface board M3     13     1     1

Nuts attaching interface board M4     13     1     1

Bus bolts and standoffs (65 frame) M4     45     4     5

Bus bolts and standoffs (92, 125, 180, 250
frames)

M5     60     5     7

Bus bolts and standoffs (375, 620, 1000,
and 1800 frames)

M6, M8     95     8   11

Diode/SCR module (620, 1000, and 1800
frames), mounting screws to heatpipe

M6     96     8   11

Bus, cable, and lug bolted connections* 1/4-20 or M6     48     4  5.4

5/16-18 or M8     96     8   11

3/8-16 or M10   168   14   19

1/2-13 or M12   420   35   47

*Note   Listed values apply to bolts torqued
by the nut.  Add 20% to the listed values for
bolts that must be torqued by the bolt head,
such as into press-nuts or cage-nuts.

5/8-11   840   70   95
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Bus Tie Splices
(See Detail 1)

Case Tie Plates
Qty: 2 Top, 2 Bottom
(See Detail 3)

Case Tie
Brackets
(See Detail 2)

Detail 2

Detail 3

Detail 1

Ground Tie Plate
(See Detail 3)

Figure 2-2.  Cabinet Tie Points
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Securing the Drive Lineup to the Floor
The drive lineup must be secured to the floor using mounting studs. Figure 2-3
shows the location of mounting holes within a drive cabinet. Figures 2-4 through
2-10 provide dimensions for the mounting studs and the mounting holes within each
drive cabinet.

Note  The drives and drive lineup do not include an option for wall-mounting.

Six 5/8" holes provided in each
enclosure suitable for use with
3/8" anchors.

Minimum of four anchors per
enclosure required.

Refer to the outline drawings (GEH-6390)
for mounting stud location dimensions.

Figure 2-3.  Location of Holes for Securing Drive Cabinet to Floor
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180* 2500 200 259B4503AO

250 408 / 900 3600 300 259B4504AO

375 5200 600 259B4505AO

Inverter

620 8000 600 259B4506AO

Figure 2-4.  Typical Outline
for 800 mm Enclosures
(65, 92,125, 180, 250, 375,
and 620 Frame Inverters)

Auxiliary   -------- Variable Variable Variable 259B4515AO

*Two inverters per cabinet; heat loss per inverter.

**Airflow throughput requirements for proper cooling.
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Dwg. (see GEH-6390)

  375 3000 259B4520AORegenerative source

  620

590 / 1300

4800
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259B4521AO

  620 3200 500 259B4531AONon-regenerative source

1000

726 / 1600

3900 700 259B4532AO

Auxiliary -------- Variable Variable Variable 259B4516AO

*Airflow throughput requirements for proper cooling.

Figure 2-5.  Typical Outline for 1000 mm Enclosures
(375 and 620 Frame Regenerative Source, 620 and 1000 Frame Non-regenerative Source, and Auxiliary)
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Standard Outline
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Auxiliary -------- Variable Variable Variable 259B4517AO

*Airflow throughput requirements for proper cooling.

Figure 2-6.  Typical Outline for 1200 mm Enclosures (Auxiliary)
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*Note:  Top cutout depth =
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frame regenerative source.
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Front
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Drive Type
Frame
Size

  Weight
(kg / lLbs)
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Standard Outline
Dwg. (see GEH-6390)

Inverter 1000 714 / 1575 12500 1800 259B4508AO

Regenerative source 1000 998 / 2200 8200 1800 259B4522AO

Auxiliary -------- Variable Variable Variable 259B4518AO

*Airflow throughput requirements for proper cooling.

Figure 2-7.  Typical Outline for 1600 mm Enclosures
(1000 Frame Inverter, 1000 Frame Regenerative Source, and Auxiliary)
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This case optional;
required for top ac
motor exit.
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Drawing Not to Scale
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Frame
Size

  Weight
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Heat Loss
(Watts)

Airflow Req.
(ft3/min) ***
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Dwg. (see GEH-6390)

Inverter 1800 1315 / 2900* 21500 3600        259B4510AO

1633 / 3600**

*Without optional case.
**With optional case.
***Airflow throughput requirements for proper cooling.

Figure 2-8.  Typical Outline for 1800 Frame Inverter (Sheet 1 of 2)
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*Airflow throughput requirements for proper cooling.

Figure 2-9.  Typical Outline for 1800 Frame Regenerative Source (Sheet 1 of 2)
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*Airflow throughput requirements for proper cooling.

Figure 2-10.  Typical Outline for 1800 Frame Non-Regenerative Source
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Chapter 3   Cabling and Connections

Introduction
This chapter assumes that
cabling was previously run to
the installation site and ready
for connection to the drive.

This chapter contains guidelines for connecting cable to the drive during installation.
This information must be used along with the following equipment drawings:

• Elementary diagrams (GEH-6389), which show electrical connections and
wiring, including terminal board I/O

• Layout diagrams (GEH-6390), which show physical location of the terminal
board and other connection points

Do not assume any cable or any circuitry to be without power
if one end of that cable could be connected to a power source.
To prevent accidental electrical shock, do not touch any
circuitry or bare wire without first ensuring that it does not
carry electricity.

When testing for the presence of electricity and when
measuring any electrical circuit, use only the equipment
approved for contact with those voltage levels.

All installations should meet the requirements of both the National Electrical Code®
(NEC®) and any applicable local codes. Use these codes to determine such factors as
wire size, insulation type, and conduit sizing.

This chapter is organized as follows:

Section Page

Drive Connections ................................................................................................... 3-2
Control Power................................................................................................... 3-4

Grounding ................................................................................................................ 3-6
Power Cabling Guidelines ....................................................................................... 3-7
Signal and Communications Cabling Guidelines..................................................... 3-9
Preventing Cable Damage........................................................................................ 3-9
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Drive Connections
Cabling and wiring connections to the drive include:

• Cabinet ground and separate CCOM ground

• Incoming ac power cables (L1, L2, L3, top or bottom entry option with ground)

• Incoming ac control power (terminals A, B, C on line side of disconnect switch
ADS with ground)

• Ac outgoing power connections to the motor (T1, T2, T3 with ground)

• Drive interface control connections to terminal board IS200ATBA

An external reactor connects to
the regenerative source L1, L2,
and L3 input (refer to Chapter
4).

The control power feed should not be tied between the reactor
output and the bridge input of a regenerative source. Refer to
the drive elementary diagram sheet CA (found in GEH-6389).

The drive User’s Guide, GEH-
6392, describes the terminal
board I/O.

Note  The drive layout drawing (see Figure 3-1) shows the location of connection
points, fuses, and other drive components. These drawings are provided in document
GEH-6390. Table 3-1 identifies the standard layout drawing for each frame size.

A device nomenclature sticker, located on the inside of the drive cabinet door
identifies the drive’s major components and their locations within the cabinet.

Customer cabling to the drive’s terminal boards must comply with level-separation
guidelines (refer to Appendix B) after it enters the drive cabinet. To meet CE Mark
requirements, all I/O wires leaving a building must be routed inside continuous
metal conduit.

Table 3-1.  Standard Layout Drawings for
Innovation Series Low Voltage Drives

Frame
Size

   Inverter
   Drawing

Non-Regenerative
Source Drawing

Regenerative
Source Drawing

       65 259B4500AL

       92 259B4501AL

     125 259B4502AL

     180 259B4503AL

     250 259B4504AL

     375 259B4505AL 259B4520AL

     620 259B4506AL 259B4531AL 259B4521AL

   1000 259B4508AL 259B4532AL 259B4522AL

Document GEH-6390
includes the drive layout
drawings.

   1800 259B4510AL 259B4533AL 259B4523AL
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Figure 3-1.  Sample Layout Drawing, 620 Frame Regenerative Source
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Control Power
The drive requisition drawings
specify the power requirements
for the application and show
connection points.

The drive control power requirements are as follows:

Voltage:  380, 415, 460, or 575 V ac, ±15% at 60 Hz; single phase

Nominal line frequency:  50 or 60 Hz, ±2%

Rating:  0.5 kVA

The CPT is mounted inside a
sheet-metal subassembly within
the drive cabinet. Its primary
fusing is located outside this
subassembly.

(Refer to Figure 3-2.) The control power transformer (CPT) primary taps are
provided for voltage selection at the front of the sheet metal assembly that supports
the control rack. Each CPT has a 230 V, .43 A and a 115 V, 3.47 A secondary
output. 2 A of the 115 V is available at DIN-rail 115E. Secondary output fuses FUI
and FUE are mounted on the DIN-rail.

Before power is applied, verify that the CPT primary winding’s
tap configuration plug is configured for the proper voltage
selection.

115E

DIN1

115E-N115E-N

115E-2N

115E-3H

115E-3N

115E-1H
115E-1N
115E-2H

115E-5N

115E-6H

115E-6N

115E-4N
115E-4H

115E-5H

FUE H

FUI H

115E-H

2A

115I-N
115I-H

4A

115E-H

115I-3N

115I-3H

115I-1H

115I-1N

115I-2H

115I-2N 115I

DIN-Rail
Mounted

415 V
380 V

460 V

3.47A
115 V

230 V
0.43 A

115VPL
2

1

230VPL
2

1

CPT
Configuration
Plug 575 V

Control Power
Transformer
(CPT)

Connect to
Proper
Terminal

To IS200HFPA
Power Supply

From Auxiliary
Device Feeder
Circuit (ADF)

(Refer to Figure 3-3.) Control power for the drive lineup is derived from an internal
3-phase control circuit called the Auxiliary Device Feeder (ADF). The ADF is a
100 A ac, 3-phase power feeder circuit originating at the source and distributed in the
overhead dc bus assembly to each dc-fed inverter.

The source’s ADIF fuses provide branch circuit protection for the 100 A conductor.
located in the overhead dc bus assembly. 30 A branch-fuse protection  (ADF1 –
ADF3) is provided with each inverter to power special devices, such as motor
cooling blowers and shaft brake controls. The optional dc disconnect switch serves
as a cutoff for the ADF power in each inverter.

To prevent equipment damage, make sure that the total
connected load currents do not exceed the ADF circuit’s rating
of 100 A.

In the non-regenerative source, the circuit can connect to either the ac incoming
power lines that feed the source, or to an independent power feed. An optional ADS
disconnect switch provides a cutoff for the incoming power.

In the regenerative source, the circuit must connect to an external source or from
the line side of the source’s ac reactor. This circuit must not connect to the load side
of the reactor.

Figure 3-2.  Diagram of CPT Power
Input and Output
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Figure 3-3.  Control Power Circuit in Drive Lineup
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Grounding
For both safety and proper functioning of the equipment, it is important that the drive
be properly grounded. The installation site must have a reliable building grounding
system and the drive’s grounding cable must be securely fastened to this system.

½ Using the elementary diagram, ground the drive lineup as follows

• Ground the drive cabinets.

• Ground the drive common (CCOM) at only one point using a separate ground
cable.

Note  As an alternate to the single point grounding methods described, CCOM can
be individually tied to the drive ground bus at each cabinet.

If you have an engineered system, consult your requisition elementary drawings for
the grounding method recommended for your installation.

• If an isolation transformer is used and the wye neutral must be grounded, use a
high-resistance ground.

• For shielded and twisted wire, ground the shields on one end only, preferably at
the drive end. Provisions have been made to tie shields to chassis ground on the
drive ATBA terminal board.

Figure 3-4 illustrates proper grounding of the drive.

Inverter Cabinet

Ground Jumper

Source Cabinet

Ground Conductors
Terminated to Cabinet
Ground Bus

Source Input Power Cables

Cabinet
Ground

CCOM

T1
T2

T3

L1
L2
L3

Metal-Clad 3-Phase
Bundle With 3
Symmetrical Grounds

Input Cables
From Transformer
Secondary

Sheath and
Ground Conductors

AC Motor

Note:  Ground Motor
Base to Ground Grid

Metal-Clad
3-Phase Bundle with
3 Symmetrical Grounds

Control Common (Run Separately to Ground)

CCOMCCOM

Additional Inverter Cabinets

Inverter Output Cables
to Motor

Sheath Terminated to
Conduit Entry Plate

Ground Conductors
Terminated to Cabinet
Ground Bus

Sheath Terminated to
Conduit Entry Plate

Figure 3-4.  Recommended Grounding for the Drive Lineup
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Power Cabling Guidelines
If help is needed, contact:

GE Industrial Systems
Product Service Engineering
1501 Roanoke Blvd.
Salem, VA  24153-6492  USA

Phone: +1 800 533 5885
Fax: +1 540 387 8606
(Replace “+” with the
international access code.)

The Innovation Series drive contains sensitive electronic equipment with high
voltage I/O requirements. This section provides general requirements for drive
cabling.

Note  Before using cable other than that recommended in this manual, consult the
GE factory for assistance.

Figures 3-5, 3-6, and 3-7 illustrate the following cable requirements:

• The recommended cabling between the transformer, drive, and motor is metal-
clad cable.

– The cable must be sized to provide adequate fault protection.

– The metal-clad cable sheath should be continuous corrugated aluminum
(not spiraled interlocking aluminum).

Note  Using metal-clad cable bundles, as described, provide a lower inductance path
to ground and substantially reduce the bearing and foot mounting capacitive currents
at the motor. This minimizes premature motor bearing wear.

A continuously corrugated aluminum sheath provides a better shield against external
electric fields than the spiraled interlocking aluminum or steel (oxidation causes high
resistance between the interlocking segments). Open wire (no sheath) is not
recommended.

An asymmetrical arrangement
of phases in a bundle can cause
unbalanced fluxes.

• Each metal-clad bundle should include all three phases, symmetrically arranged.

• If multiple conductors are needed for current rating, configure them as multiple
3-conductor metal-clad bundles, each including all three phases.

• When using continuous corrugated aluminum:

– The preferred configuration is three symmetrically arranged ground
conductors within each cable bundle.

– Otherwise, in the cable bundle, there should be at least one asymmetric
ground conductor that has sufficient ampacity to meet NEC requirements.

• When using rigid conduit or spiraled interlocking aluminum, the ground
conductor should be centered within the bundle.

• Terminate the sheath to the motor junction box and to the inverter cabinet (see
Figure 3-4) using approved connectors.

• Terminate the ground conductors close to the cable entry according to applicable
codes. If no other codes apply, connect the ground conductors according to the
NEC requirements, which presently are:

– At the motor to a ground lug (usually in a connection box)

– And at the inverter to a ground terminal on the inverter cabinet sheet metal.

• Metal-clad bundles may be run close to other metal-clad motor power cables
without considering electrical coupling. However, thermal rules do apply when
determining spacing.
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Preferred: Use this cable, if
available.

Continuous Corrugated
Aluminum  Sheath

Insulating Protective
Outer Jacket (PVC)

Inert Filler

PVC Inner Jacket
or Lapped Tape

Insulated Phase
Conductors (3)

Bare Ground
Conductors (3)

Figure 3-5.  Recommended Power Cable Configuration (Preferred)

Use this cable, if cable in
Figure 3-5 is not available.

Inert Filler

Bare Ground
Conductor

Continuous Corrugated
Aluminum Sheath

PVC Inner Jacket
or Lapped Tape

Insulated Phase
Conductors (3)

Insulating Protective
Outer Jacket (PVC)

Figure 3-6.  Recommended Power Cable Configuration

Use this cable, if cable in
Figures 3-5 and 3-6 are not
available.

Continuous Corrugated
Aluminum Sheath

Insulating Protective
Outer Jacket (PVC)

Inert Filler

PVC Inner Jacket
or Lapped Tape

Insulated Phase
Conductors (3)

Bare Ground
Conductor

Figure 3-7.  Alternate Power Cable Configuration
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Signal and Communications Cabling Guidelines
• Be sure to strictly follow the cable manufacturer’s installation instructions.

These will vary based on the type of installation required.

• Signal inputs to low-level (refer to Appendix B) analog and digital blocks or to
programmable logic control (PLC)-related devices should be run as shielded
twisted-pair (for example, inputs from RTDs and encoders).

• To meet CE Mark requirements, all I/O wires leaving a building must be
routed inside continuous metal conduit.

• The PC connects to a plug located on the drive cabinet door below the Drive
Diagnostic Interface (DDI, also called keypad). The other side of this plug
connects a cable to connector J9 on the control rack backplane. (See Figure 3-8
for details, including recommended cable part number.)

Note  The PC-to-drive cable is not provided with the drive and must be ordered
separately. Using a ferrite core on long PC-to-drive cable lengths improves
communication.

Preventing Cable Damage
• Be sure to comply with OSHA and other applicable regulations.

• Observe minimum installation temperature to avoid damage to shielding and
insulation.

• Do not pull cables around corners with sharp edges or corners that prohibit the
minimum allowable cable-pulling radius.

• Avoid high mechanical stress (pull tension). The cable should not be excessively
twisted, stretched, or flexed.

• Before pulling cable, inspect all cable trays. Cable should only be pulled into
clean trays. Install bushings and dropouts, as necessary.

• Make sure that cable ends are sealed before, during, and after pulling the cable.
This prevents the entrance of water or other contaminants.
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To Control Rack Backplane,
J9 Connector
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8

PlugPlug

Drive J9
Connector

Drive Door
Connector

GE Part #336A6405G1
9-Pin Plug to 9-Pin Plug

7.5 ft

Drive Door-to-Backplane Cable

PC Serial
Port

2
3
4

5
6

7
8

2
3
4

5
6

7
8
Receptacle Receptacle

Drive Door
Connector

PC-to-Drive Cable

GE Part #336A3582P1
9-Pin Receptacle to
 9-Pin Receptacle

25 ft

PC-to-Drive Cable

Drive Door-
to-Backplane
Cable

1 11

Rack Backplane,
J9 Connector

Control Rack
(See Chapter 6
for Detail.)

Figure 3-8.  Cabling and Connections Between PC and Drive
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Chapter 4   Device Installation

Introduction
This chapter defines mounting and installation instructions for external devices that
are connected to the drive as part of the drive system. This information is presented
as follows:

Section Page

Tachometer Mounting.............................................................................................. 4-2
Motor Shaft Ground Brush ...................................................................................... 4-3

Installing the Ground Brush.............................................................................. 4-3
Line Filter Assembly (Non-Regenerative Source)................................................... 4-4

Line Filter Specifications.................................................................................. 4-5
Optional Line Reactor (Non-Regenerative Source) ................................................. 4-6

Selecting the Line Reactor................................................................................ 4-6
Reactor Assembly (Regenerative Source) ............................................................... 4-8

With power applied, extremely high voltages are present on
some circuitry. To prevent accidental injury, do not touch any
circuitry without first ensuring that it does not carry these
voltages and is grounded.
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Tachometer Mounting
If the motor is equipped with a tachometer, check that it is correctly installed before
energizing the motor. The tachometer should normally be mounted opposite the
drive end of the motor (see Figure 4-1). The bearing on this end of the motor is
normally an insulated bearing.

Tachometer

Insulated Bearing

Motor

Non-Insulated Bearing

Ground Brush Coupling

Opposite Drive End (O.D.E.) Drive End (D.E.)

Figure 4-1.  Typical Motor Configuration with Tachometer and Ground Brush
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Motor Shaft Ground Brush
Before energizing the motor, check that the specified ground brush is mounted
correctly on the motor shaft. Typically, it is mounted at the motor’s drive end (see
Figure 4-1).

Electrical motors usually contain a non-insulated bearing on the drive end and an in-
sulated bearing on the opposite end.

Note  If the tachometer end of the motor shaft comes with a shaft grounding option,
remove this ground before proceeding.

The brush holder assembly is mounted outside the bearing housing. When properly
installed, the carbon brush makes contact with the shaft through spring tension (see
Figure 4-2). It is important that this contact be continuous to ensure that any charge
buildup on the shaft is taken to ground through the brush and not through the
bearing.

Installing the Ground Brush

To prevent possible motor bearing damage, the brush holder
assembly (when specified) must be installed securely in place
and make good contact between the shaft and ground.

½ To install the brush holder assembly

1. Make sure that the shaft is clean. Use fine sandpaper or emery cloth, if
necessary.

2. Mount the brush holder assembly to the load end of the motor shaft. Keep the
gap between the brush holder and shaft to 0.1 inch.

As preventive maintenance, check the carbon brush insert every month and replace
once a year. As a maintenance aid, mount a stick-on reminder nameplate (see Figure
4-3) in a visible, nearby location.

Spring
Brush
Holder

Shaft

Brush

Figure 4-2.  Mounted Brush Holder Assembly

CAUTION

SHAFT GROUNDING BRUSH
LOCATED ON MOTOR SHAFT

REPLACEMENT BRUSH PART
NUMBER _________________

Figure 4-3.  Sample Brush Holder
Reminder Nameplate
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Line Filter Assembly (Non-Regenerative Source)
GE document GEH-6389
contains standard elementary
diagrams for the non-regenera-
tive sources.

The line filter assembly, typically roof-mounted, is a line-to-line RC (resistor-
capacitor) filter network (see Figure 4-5) on the 3-phase power input of a non-
regenerative source. It provides softening for line voltage transients, which may
inadvertently cause the source SCRs to misfire. The filter also provides attenuation
for any high-voltage transient spikes that might otherwise surpass the voltage rating
of the power devices.

Note  The line filter is required at all times.

The following standard elementaries apply to the non-regenerative sources:

Frame Size Drawing No.

  620 259B4531AE

1000 259B4532AE

1800 259B4533AE

K3

K2

L3

L2

K1

Circuit Breaker

L1

ACD

ACFU3

ACFU2

ACFU1

FU1
2
LFFUTB1

FU2

FU3

Line Filter Fuse Assembly

1

1

1

2

2

L1

L2

L3

Line Filter Assembly

(H1)(X1)

(H2)(X2)

(H3)(X3)

Supplied
Customer

3-phase
Input
Power

kVA

Transformer

Non-Regenerative Source  Drive

Figure 4-5.  Line Filter Assembly Connections
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Line Filter Specifications
When the non-regenerative source’s input power comes from:

• Either an individual transformer (as shown in Figure 4-5)

• Or a common transformer with other non-regenerative sources and either of
the following:

a. dc drives (in addition to the listed filters, dc drives require line filters
for their own applications, as covered in the dc drive documentation)

b. one 1000 frame regenerative source, run at 1.5 kHz maximum

c. one 1800 frame regenerative source, run at 1.5 kHz maximum (see
Note 1)

Use these line filters:

Non-regenerative
Source Frame Size Line Filter Part No. Quantity Line Filter Description

620 173C9226SZ  G01 1 1 µf with 30 ohms

1000 and 1800 173C9226NM  G01 2 2 µf with 15 ohms

1000 and 1800* 173C9226NM  G01 2 in parallel Result:  2 µf with 15
ohms

*Note 1:  For application “c” (above) only. Each filter must be wired separately to its
own set of 10 A JKS fuses.

All other applications must use a separate isolation transformer. This includes
regenerative sources running at frequencies greater than 1.5 kHz and multiple
regenerative sources.

Wiring
The filter must be wired with AWG no. 10 or larger wire. The wire length must be
less than 12 ft from the filter, through the filter fuses (10 amp JKS, mounted in the
source), to the SCRs in the bridge.
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Optional Line Reactor (Non-Regenerative Source)
In some instances, additional line reactance is required to provide limiting of poten-
tial short circuit currents, or to provide sufficient reactance for the commutation of
the regenerative source power devices.

When supplied, the reactor is remote mounted. The non-regenerative source line
filter always be connected on the load side (source side) of the reactor.

Selecting the Line Reactor
Non-regenerative sources, whether on individual transformers or on a common trans-
former, require a minimum transformer inductance of 12 µH per phase. Calculate the
transformer inductance using the equations and guidelines described below.

½  Input power from an individual transformer

LT = [(% imp) x (VL-L) x 106] / [100 x √3 x 377 x (IFL)]

Where:
LT = per phase transformer inductance, (µH)

VL-L = line-to-line voltage

% imp = impedance of the transformer

IFL = transformer rated current, (amps)

IFL = [(kVA) x 1000 x √3] / [VL-L x 3]

377 = 2πf; where f is 60 Hz; for 50 Hz, change 377 to 314

If the transformer inductance is less than 12 µH, add a line reactor from Table 4-1.

Note  The ac line power wiring can be used as a source of inductance. See the Table
4-2 for wire inductance values.

½  Input power from a common transformer with only non-regenerative
sources and dc drives

Calculate the transformer inductance using the equation and guidelines for sources
with an individual transformer.

Additionally, you should consider that the minimum inductance between individual
non-regenerative sources and between non-regenerative sources and the dc drives
must be 5 µH per phase.

½  Input power from a common transformer with  non-regenerative
sources and a 1000 or 1800 frame regenerative source

Non-regenerative sources, on a common transformer with a regenerative source, re-
quire a minimum parallel source inductance of 12 µH per phase. Calculate the trans-
former inductance using the equation and guidelines for sources with an individual
transformer, with the following additional considerations:

• The 1000 frame regenerative source has 110 µH of inductance.

• The 1800 frame regenerative source has 63 µH of inductance

• The parallel source inductance is:

[(LT) x (110)] / [LT + 110] or (LT) x (63)] / [LT + 63]

Additionally, you should consider that the minimum inductance between individual
non-regenerative sources and between non-regenerative sources and the dc drives
must be 5 µH per phase.
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Table 4-1.  Line Reactor Selection*

Drive
Frame Size

Part No.
(TRENCO)

Inductance
(µH)

Reactor
Current Rating

(amps)

Size
(H x W x D in inches)

Weight
(lbs)

620 TR-17213 5 650 38 x 24 x 21 250

620 TR-17065 12 650 38 x 24 x 21 300

1000 TR-1706 5 820 38 x 24 x 21 300

1000 TR-17062 5 1050 51 x 28 x 30 400

1000 TR-17066 12 820 38 x 24 x 21 400

1000 TR-17067 12 1050 51 x 28 x 30 500

1800 TR-17214 5 1400 51 x 28 x 30 475

1800 TR-17064 5 1550 51 x 28 x 30 500

1800 TR-17068 12 1400 51 x 28 x 30 650

1800 TR-17069 12 1550 51 x 28 x 30 700

*Select a reactor based on the maximum continuous dc current where:
maximum continuous dc x .816 = reactor current

Table 4-2.  Typical Copper Wire Inductance Per Foot

AWG
Inductance
Per Ft (µH)

    4 .6969

    3 .5573

    2 .4491

    1 .3638

 1/0 .2972

 2/0 .2466

 3/0 .2065

 4/0 .1759

250 .1609

300 .1459

350 .1346

400 .1290

500 .1196

600 .1155

750 .1099
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Reactor Assembly (Regenerative Source)
GE document GEH-6389
contains standard elementary
diagrams for the regenerative
sources.

The regenerative source receives ac input power from an external reactor assembly
(see Figure 4-4). The reactor must connect to the transformer output and source input
lines exactly as shown on the drive elementary diagram.

To prevent possible damage to the drive bridge, check that the
reactor lines are connected correctly, per the drive elementary
sheet 4FA.

The following standard elementaries apply to the regenerative sources:

Frame Size Drawing No.

  375 259B4520AE

  620 259B4521AE

1000 259B4522AE

1800 259B4523AE

K3

K2

L3

L2

K1

Circuit Breaker

L1

ACD

*ALSA snubber board must NOT be connected
on the drive side of the reactor.

External Reactor Assembly

5

3

1 30 A 600 V

FU2

FU3

FU1
ALSA*

6

4

GND

MOVs

2

Regenerative Source Drive

ACFU3

ACFU2

ACFU1

(H1)(X1)

(H2)(X2)

(H3)(X3)

Transformer

Supplied
Customer

3-phase
Input
Power

kVA

Figure 4-4.  Reactor Assembly Connections

The ALSA snubber board, located in the external reactor
assembly (see Figure 4-4) must not be connected on the drive
side of the reactor. Otherwise, it may overheat.
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Chapter 5   Pre-Powerup Installation
Checks

Introduction
This chapter must be completed
before beginning startup.

This chapter contains instructions to verify that the drive lineup is ready for startup.
This includes checks and procedures to ensure that the drive communications, I/O,
and power connections are working correctly.

In these instructions, the term drive applies to both the source and inverter. Any
instruction that applies to only the source or the inverter(s) will specify that.

All instructions must be followed and completed in the order
presented.

It is good practice to check off each procedure when you
complete it. For this purpose, this chapter includes checkboxes
next to each procedure heading

This chapter assumes that the drive lineup and connected devices have already been
installed, and that all wiring and cabling are installed correctly. It is presented as
follows:

Section Page

Equipment/Material Needed .................................................................................... 5-2
Securing the Equipment for Safety .......................................................................... 5-2
Hardware Checks..................................................................................................... 5-3
Optional Megger Test .............................................................................................. 5-5

Pre-Test Power Checks..................................................................................... 5-5
Non-Regenerative Sources ............................................................................... 5-6
Regenerative Sources and Inverters.................................................................. 5-6
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Equipment/Material Needed
Checkboxes should be marked
to verify that equipment is on-
hand.

Check that the following equipment and materials are available for the procedures in
this chapter.

� Locks and tags, danger and caution tape

� Source of low-pressure, compressed, dry air (less than 15 psi) or clean, dry cloth

� Small standard (flat-head) screwdriver

� Torque wrench

� Socket sets, standard and metric

� Digital multimeter

� One dc megger tester (voltage not to exceed 500 V), optional

� Drive elementary diagrams, document GEH-6389

� Drive Layout and Outline Drawings, document GEH-6390

� Drive User’s Guide, document GEH-6392

Securing the Equipment for Safety
� All procedures in this section
were completed successfully.

1. Lock out and tag out all voltage sources to the drives. Apply safety grounds per
local rules and regulations.

2. Make sure that the motor area is taped off while tests are being done.

3. If supplied, connect and energize the motor space heater to remove any mois-
ture.

4. Provide a temporary means to stop the drive at the motor. For example, install a
Test Stop switch at the motor.
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Hardware Checks
� All procedures in this section
were completed successfully
for:

     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3

In this manual, the term
“drive” is used for both the
source and inverter.

All drives are factory-tested and operable when shipped to the installation site.
However, connections could loosen during shipping and handling. To help ensure
successful startup, check the drive hardware after installation and before initial
powerup.

½ For each drive in the lineup, check drive hardware as follows

1. Become familiar with the drive one-line on elementary sheet CA.

2. Make sure that the equipment is secured for safety, as required in the previous
section.

3. Using an approved tester for the voltage levels being measured, verify that
power has not yet been applied to the circuitry.

With power applied, extremely high voltages are present on
some circuitry. To prevent accidental injury, do not touch any
circuitry without first ensuring that it does not carry these
voltages and is grounded.

When testing for the presence of high voltages and when meas-
uring any electrical circuit, use only the equipment approved
for contact with those voltage levels.

4. Using either low-pressure, compressed, dry air or a clean, dry rag, remove any
dust that may have accumulated in the drive’s interior.

5. Inspect wiring to ensure that it has not been damaged or frayed during installa-
tion. Replace if necessary.

6. Check that all electrical terminal connections are tight.  Refer to the torque val-
ues in Tables 5-1.

7. Check that all devices, modules, and boards have not been damaged during
handling or installation, are that they are secure in their mounting connections.
Refer to applicable torque values in Tables 2-2.

To prevent component damage caused by static electricity, treat
all boards and devices with static-sensitive handling techniques.
Wear a wrist grounding strap when handling boards or compo-
nents, but only after boards or components have been removed
from potentially energized equipment and are at a normally
grounded workstation.

Note  To ensure that electrical connections remain tight, re-check them within three
to six months after initial powerup, and annually thereafter. Use screwdrivers and
torque wrenches for these checks.
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Appendix A describes the IPN
number.

8. Check that the correct shunts have been installed and that the shunt cables are
installed correctly. (Refer to the drive elementary data sheet BA or intelligent
part number (IPN).)

9. Check fusing in the drive cabinet (refer to the elementary or to the drive nomen-
clature sticker located inside the drive cabinet door).

10. Verify that the BAIA board as listed on the drive elementary data sheet BA has
correct settings for analog input jumpers AIN1 and AIN2, as follows:

Position
JP5A & JP6A (VIN)
for 610 V dc mode

Position
JP5B & JP6B
for 4-20 mA mode

BAIA Board, Side View

Insert Into Control Rack

AIN1

AIN2

TP1

TP2

ACOM
TP3

JP5B

AIN1
JP5A

VIN
1

4 - 20 MA

JP6B

AIN2
JP6A

VIN
1

4 - 20 MA

11. Check incoming wiring/cabling, as follows:

a. It should be complete and agree with the elementary drawings supplied with
the drive.

b. It should conform to the cable separation guidelines defined in Appendix B.

If 115 V ac or 120 V dc is used for the system and/or local fault
string, make sure that only terminal points 2 and 8 are used on
the ATBA board. Terminals 4 and 10 on the ATBA are for the
24 V power supply (see elementary sheet DA).

12. Verify that the cabinet is properly grounded, including CCOM that is separate
from power ground (refer to Chapter 3).

13. Operate each magnetic device by hand to make sure that all moving parts oper-
ate freely. Check all electrical interlocks for proper operation.

14. Verify that the incoming and outgoing buses are not grounded. To do this:

• Either use an ohm meter to measure all buses in the drive to ground to
ensure insulation integrity,

• Or perform the optional megger test (refer to the following section).
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Optional Megger Test
A megger (megohm meter) meas-
ures resistance by placing volt-
age across a device.

This optional test verifies that the system-to-ground insulation has not been damaged
during shipping or installation. The procedures vary for the non-regenerative source,
regenerative source, and inverter drives, as described below. However, pre-test
power checks apply to all drives.

To prevent circuit damage:

•  The megger voltage should not exceed 500 V dc.

•  Do not use ac meggers for this procedure.

Pre-Test Power Checks

With power applied, dangerous voltages are present on some
circuitry. To prevent accidental injury, do not touch any
circuitry without first ensuring that it does not carry these
voltages and is grounded.

½  Before conducting the megger test on any drive, check for the pres-
ence of power on the circuitry, as follows

1. Check that the ac bridge power and control power have been locked out and
tagged out.

The drive layout drawing
(listed in Chapter 3, Table 3-1)
shows location of fuses, discon-
nects, and other components
within the drive cabinet.

2. Open both the control and line disconnect (circuit breaker or switch) in the
source drive.

Note  There could be multiple sources of power in the enclosure.

3. Disconnect all inverter drives on the dc bus, either through the dc disconnect or
by disconnecting the dc fuses at the inverter.

4. Using a voltmeter, check that the dc bus voltage has discharged to below 1 volt
on the following circuits.

Use the checkbox to mark each
completed measurement.

o  Line to line

o  Line to ground

o  Line to P-bus

(Capacitors are connected across the P-bus and N-bus. Therefore, the voltage
reading will be low and show charging of the capacitors.)

o  Line to N-bus

o  P-bus to N-bus

o  P and N-bus to ground.

Non-regenerative source drives
include diodes in the power
bridge.

Note  Readings could be affected by the drive’s line-to-line filters and dc bus
capacitors and bleeder resistors.

Circuits with diodes require reading proper polarity so that results are not mislead-
ing. Refer to the elementary diagrams (GEH-6389) for assistance.

5. Continue the megger procedures that follow for the type of drive being tested.
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� All procedures in Option 1
or Option 2 were completed
successfully.

Non-Regenerative Sources

½  Option 1:  Megger test across power buses

1. Do not proceed until completing all requirements under Pre-Test Power Checks.

2. Short the ac and dc buses together using jumpers or wire.

3. Connect one side of the megger to one of the buses and the other side to ground.

4. Apply the megger voltage (not exceeding 500 V dc).  The reading should be
greater than 100 megohms.

5. If readings are low, identify and correct the problem before proceeding.

6. Remove all jumpers or wires from the bus before applying any power.

½  Option 2:  Megger test using IS200RCSA board testpoints (1000 and
1800 frame drives)

An IS200RCSA board provides
snubber circuitry to protect the
devices on a bridge phase.

1. Do not proceed until completing all requirements under Pre-Test Power Checks.

2. On one of the three IS200RCSA boards, connect the megger from the following
testpoints, one at a time, and check for values greater than 100 megohms:

• K1 to ground

• A1/K2 to ground

• A2 to ground

3. If readings are low, identify and correct the problem before proceeding.

4. Repeat this test (steps 2 and 3) for each of the two remaining RCSA boards

Regenerative Sources and Inverters

All procedures in this section
were completed successfully
for:
     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3

1. Do not proceed until completing all requirements under Pre-Test Power Checks.

2. Use single strand wire or jumpers to make a continuous connection to all the
following points:

• All gate, collector, and emitter points (the bolts) on boards mounted to the
IGBTs.

Note  Do not loosen bolts on the IGBT to make these connections. (Bolts are
specifically torqued.) Instead, wrap the wire around the bolts. This sufficiently shorts
all IGBTs.

• On sources, across the input contactor

• On inverters, all three shunts

• Both dc buses (P and N)

• ATB terminal board. This includes the primary of the CPT in the test.

3. Make sure that there is a secure ground connected to the cabinet (case).

4. Connect the megger ground lead to the cabinet ground.

5. Connect the megger hot lead to the continuous jumper in step 2.

6. Apply the megger voltage (not exceeding 500 V dc). The reading should be
greater than 100 megohms.

7. If readings are low, identify and correct the problem before proceeding.
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Chapter 6   Startup and
Commissioning

Introduction
. This chapter provides instructions to verify that the drives are in good running

condition and to prepare them for operation. This includes control power checks,
software setup, and tuneup and commissioning guidelines.

This chapter is presented as follows:
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Optional:  Upgrading the .icb File .................................................................. 6-13

Checking for Correct Firmware and Hardware...................................................... 6-15
Checking the Keypad (DDI) .................................................................................. 6-17

Using the Keypad for Startup and Commissioning......................................... 6-17
Adjusting Keypad Display Contrast ............................................................... 6-18

Commissioning the Drive ...................................................................................... 6-20
Overview of Drive Parameters/Wizards ......................................................... 6-20
Running the Commissioning Wizard.............................................................. 6-24
Running the Cell Test Wizard ........................................................................ 6-26
Optional:  Using the Trend Recorder to Observe Cell Test ............................ 6-27
Running the Tuneup Wizards (Inverters Only)............................................... 6-29
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Before Beginning
Before beginning the procedures in this chapter, the following conditions must be
true for all drives in the lineup:

• All pre-startup and installation checks from the previous chapters are completed
successfully.

• All interconnecting wires and cables are in place, connected, and ready for
power on.

• Power is not yet applied.

User’s Guide, GEH-6392,
 includes a functional descrip-
tion of the drives, including
hardware structure.

Order of Startup
Although the Innovation Series low voltage drives include many different frame
sizes of both sources and inverters, the design incorporates a common hardware and
software structure. Therefore, the basic startup and commissioning procedures are
identical for the different types of drives.

Each drive in the lineup must be started up and commissioned individually, using the
following guidelines:

• Complete the procedures in this chapter for the source first, then for each
inverter, one at a time.

• Follow the procedures in this chapter in the order presented.

• Figure 6-1 is a flowchart for use as a visual guide to the startup and commis-
sioning process.

The order of startup is important. The source must be checked
and set up first, since it supplies control power and the dc bus to
all drives in the lineup.

All instructions must be followed and completed in the order
presented in this chapter.

Tip ©  It is good practice to check off each procedure when you complete it. For
this purpose, this chapter includes checkboxes next to each procedure heading.

Information Needed
Before beginning, you should review the applicable elementaries and layout draw-
ings to become familiar with the type of drives in the lineup. Make sure you know
the power requirements and location of components, connections, and power
switches.

Appendix A provides informa-
tion about the intelligent part
number and its relationship to
the pattern number.

When configuring the drive with the GE Control System Toolbox, you need to know the
firmware pattern for each drive in the lineup (for example, accbn-a for the source
and acdcf-v for the inverter), which is included in the drive’s intelligent part number
(IPN).
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Checkboxes should be marked to
verify that equipment is onhand.

Equipment/Material Needed

Safety Equipment

� Safety gear (safety boots, safety glasses, hard-hat, high voltage gloves, face
shield)

� Locks, tags, and danger and caution tape

Typical Test Equipment

When testing for the presence of high voltages and when meas-
uring any electrical circuit, use only the equipment approved
for contact with those voltage levels.

� Digital multimeter

� Small standard (flat-head) screwdriver

� Socket sets, standard and metric

� Flashlight

� Personal computer (PC) with the GE Control System Toolbox installed

Reference Documents

� System elementaries or standard drive elementaries in GEH-6389 (required)

Tip ©  It is good practice to study the drive elementary before working on the drive.

“GEH-####” is the document
identification number.

� Drive layout and outline drawings, GEH-6390

� Drive User’s Guide, GEH-6392

� GE Control System Toolbox document, GEH-6401

� Reference and Troubleshooting guide for your product’s firmware pattern
identify:

GEH-6393 for ACDCF-G

GEH-6394 for ACDCF-S

GEH-6395 for ACDCF-V

GEH-6396 for ACCBN-A

GEH-6397 for ACCBR-A

The information contained in the GE Control System Toolbox
document GEH-6401 and in the Reference and Troubleshooting
documents is also available as Help files within the toolbox
program (refer to Using Toolbox Help in this chapter).
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Apply & Verify Control  Power

Check Processor Start

Install Toolbox

Install Drive Components

No

Yes

Start Toolbox

Create a New Drive
Configuration File (.icb)

No

Yes

Open the Drive
Configuration File (.icb)

(Toolbox Version is
Automatically Verified)

Message:
 File last saved with

older version toolbox
?

Get Old Toolbox
or Upgrade the file

Yes

Start

B

1

1a

2

3

4

Get New Toolbbox

No
Message:

 File last saved with
newer version toolbox

 ?

Yes

Is drive
configuration file
pre-engineered

?

Is Control System
Toolbox Installed?

4a 4b

No

Refer to section:
Verifying Control Power and
Checking Processor Start

Refer to:
Toolbox document
GEH-6401.

Refer to section:
Starting the Toolbox

Refer to section:
Creating a New Drive
Configuration File

Refer to section:
Open a Drive File

4a and 4b:
Refer to Toolbox document
GEH-6401

Figure 6-1.  Overview of Drive Startup and Commissioning (Part 1 of 2)
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Review Release Notes

Create Version Summary*

B

Establish
Communications

with the Drive

Do drive & file pattern
versions agree?

Yes

No Is drive newer
than file?

Upgrade File

Yes

Download Flash

(File is newer than drive.)

No

5

6a

6b

7

6

Check Hardware

Check Firmware

Check Keypad

8

Run the
Commissioning Wizard*

9

Run the Cell Test Wizard*

and Autotune Wizards*

10

End

*Can also be done from the keypad. Refer  to
drive User’s Guide GEH-6392 for procedures.

5 and 6
Refer to section:
Checking Toolbox/Drive
Pattern Compatibility

Refer to section:
Downloading to
the DriveRefer to section:

Optional: Upgrading
the .icb File

Refer to section:
Checking for Correct Firmware
and Hardware

Refer to section:
Checking for Correct Firmware and Hardware
and
Checking the Keypad (DDI)

Refer to section:
Running the Commissioning Wizard

Refer to section:
Running the Cell Test Wizard
and
Running the Tuneup Wizards

Figure 6-1.  Overview of Drive Startup and Commissioning (Part 2 of 2)
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Verifying Control Power
Refer to the Control Power section in Chapter 3 for an overview and diagrams of the
drive lineup’s control power circuitry.

Refer to Figure 6-1, Block 1.

All procedures in this section
were completed successfully
for:
     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3

With power applied, this equipment contains a potential hazard
of electric shock or burn. Only personnel who are adequately
trained and thoroughly familiar with the equipment and the
instructions should install, operate, or maintain this drive.

To minimize hazard of electrical shock or burn, approved
grounding practices and procedures must be strictly followed.

1. Before energizing the ADF circuit, verify that the CPT configuration jumper is
set to the proper tap in each drive in the lineup (refer to Chapter 3).

2. Measure the line-to-line voltage of the control power supplied to the auxiliary
device circuit switch (ADS) to ensure that it is consistent with the CPT jumper
settings.

3. After energization, verify the 115 V ac secondary at each drive at the 115E and
115I terminal strips (provided on the left-hand sidewall of the drives; refer to
Figure 3-2).

4. Check that the rack power supply is correct by monitoring the testpoints on the
RAPA board with respect to DCOM:  5 V (P5) ±5%, +15 V (P15) ±5%, -15 V
(N15) ±5%. (Refer to Figure 6-2.)

5. Measure the voltage at the ATBA board’s terminal points 33 (I24P) and 35
(I24N). This voltage is unregulated 24 V dc (18 to 24 V dc).

6. Check the LEDs on all DSFC and DAM_ inverter gating boards, as follows:

“DSFC” is the IS200DSFC
Driver/Shunt Feedback board.

“DAM_” is the IS200DAM_ Gate
Drive Amplifier and Interface
board.

• Green LED, on (illuminated) when the IGBT is commanded to an off state
(-15 V dc, gate to emitter for DFSC and -7.5 V dc for )DAM_)

• Yellow LED, on when the IGBT is commanded to an on state (+15 V dc ±,
gate to emitter)

Note  During normal operation, both the green and yellow LEDs appear to be on.
However, they are actually alternating at a very high frequency.

• Red LED (DSFC only), on when the dc bus voltage is above 50 V dc

The DSFC and DAM_ boards located in the power bridge at the IGBT modules, as
follows:

Board Frame No. Boards per Drive

DSFC 1000 3 (2 per phase leg)

DSFC 1800 6 (4 daisychained per phase leg)

DAMA    620 3 (1 per phase leg)

DAMB    375 3 (1 per phase leg)

DAMC    250 3 (1 per phase leg)

DAMD    180 3 (1 per phase leg)

DAME      65 1 (for all 3 phases)
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Checking Processor Start
Refer to Figure 6-1, Block 1.

All procedures in this section
were completed successfully
for:
     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3

Verify the that the DSPX processor board, located in the control rack, has started
correctly, as follows:

1. The DSPX should boot-up with the following LED indications:

• Green status LED steady on

• Red fault LED blinking (indicating an alarm status because the dc bus is not
charged up; solid red indicates a fault condition)

2. For the other boards in the rack, check that the green LEDs are steady on.

Control Rack Fan
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5
J9

24 21

4
J7

1

36

33

J6
4

1

R
X

T
X

T
X

R
X

T
X

T
X

J1 = Regenerative
source contactor
interface

J2 =Interlock to
incoming disconnect
(if supplied)

J3/J5 =  Power supply
connection from
IS200HFPA

J4A, not used

J6, J7 = Connection
to IS200ATBA for
User I/O

J8 = Connection to
Meters (if supplied)

J9 = PC Connection
(see Chapter 3 for
details.)

J10 = Connection to
Keypad (DDI)

J11A, J11B = Local
ISBus Interface

J12A, J12B = System
ISBus Interface

Communication
Module
Option

Board Function
BAIA Basic I/O
BICL Bridge Interface
BPIA/B Bridge Personality Interface
CABP Control Rack Backplane
DSPX Digital Signal Processor
SCNV SCR/Diode Converter Interface

Module Function
ACL_ Application Control Layer
GBIA GeniusTM Bus Interface
PBIA PROFIBUS-DP Interface

Control Rack Boards: Communication Module Options:

Figure 6-2.  Front View
of Control Rack
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Using the Drive Configuration Tools
GE document GEH-6401
describes toolbox installation
and use.

The GE Control System Toolbox is a Microsoft® Windows®-based, drive configu-
ration program used to tune and commission the drive as needed for each applica-
tion. The toolbox is designed with menus, block diagrams, dialog boxes, and wizards
that simplify and guide you through the startup and commissioning process.

This chapter provides guidelines for using the toolbox to download and apply the
drive pattern (application firmware specific to each drive type). For detailed infor-
mation, you should refer to either the toolbox online Help or the product documents
listed in the Tools/Materials Needed section.

Note  To indicate that an item discussed in a procedure is also displayed in the
toolbox, the item is bolded.

Using Toolbox Online Help

Tip ©  It is good practice to refer to the toolbox Help for any part of toolbox opera-
tion or menu and dialog options that you do not fully understand. You can access the
Help files at any time after the toolbox is installed on your PC.

The toolbox Help feature provides detailed information about using the toolbox. This
includes installation and operation, as well as drive configuration instructions. There
are several ways to access Help while running the toolbox.

For Do this

Menu commands Highlight the command and press function key F1.

Dialog boxes Press F1 when the dialog box displays on the screen.

Block information Click on the desired block with the right mouse button and
choose Item Help.

Help contents Choose Help then Contents.

Help Choose Help then Using Help.

Specific word(s)
Choose Help then Contents and Find. From there, enter the
word(s) you want to find.

When you choose Help on the toolbox main menu bar, a drop-down menu provides
several options for finding information.

Organized Help topics, a Help Index tab,
and a Find tab for searching the Help
database.

How to find information in Help and how to
customize the toolbox Help features.

Information about faults, functions, wizards,
and special messages.

Information about the drive and toolbox
version, installation notes (compatibilities),
and requirements.

Send a toolbox "bug" report or
enhancement request directly to GE
(requires that e-mail is installed).

Additional information about the toolbox
and GE contacts (requires access to the
GE intranet).

Identifies toolbox release, version, and
platform information.
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When you choose Help then Contents, the displayed screen provides several easy-
to-use options for finding information.

To access this screen, select Help
on the toolbox menu bar, then select
Contents from the drop-down menu.

Displays an organized list of
toolbox help topics, matching
toolbox User document GEH-6401.

Displays an alphebetized list of
toolbox help topics.

Allows you to search for a Help
topic by entering a word into a text
box.

Doubleclick an open-book icon to
hide topics listed under that
heading.

Doubleclick a question icon to
display help information for the
topic beside it.

Doubleclick a closed-book icon to
display topics listed under that
heading.

Refer to Figure 6-1, Block 2.

All procedures in this section
were completed successfully
for:
     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3

GE provides the toolbox and
drive configuration files on the
Control System Solutions CD.

Starting the Toolbox
The remaining procedures in this chapter require that you use the toolbox.

½  To start the toolbox

1. Make sure that the toolbox is installed on the PC and that the PC is connected to
the drive control. If it is not, refer to toolbox document GEH-6401 for installa-
tion instructions.

2. Select the Windows Start button, then Programs, GE Control System
Solutions, Control System Toolbox, and Control System Toolbox.

This should start the toolbox, which will open into a blank screen.

3. Select Help then About Toolbox to view the toolbox version (for example,
Version V06.00.19C).

You are now ready to configure drive software, as described in the next section.
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Configuring Drive Software
Refer to Figure 6-1, Block 4.

All procedures in this section
were completed successfully
for:
     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3

Open a Drive File
To configure drive software with the toolbox, you must open the drive configuration
(.icb) file. If the drive was pre-engineered, you have an existing .icb file. Otherwise,
you must create a new one.

½  To open an existing drive configuration file

1. From the toolbox menu, select File then Open. This displays the default
directory where the .icb files are stored.

2. Select the desired .icb file then the Open button.

The toolbox then determines if the .icb file was created with the same version of
toolbox . If not, it displays one of two messages.

3. If the .icb file was last edited with an older version toolbox, you can either
obtain and install the older version of the toolbox, then repeat steps 1 and 2, or
continue to open the file.

4. If the .icb file was last edited with a newer version toolbox, obtain and install
the newer version of the toolbox, then repeat steps 1 and 2.

5. When the toolbox opens, it displays the toolbox main screen (described in
Appendix E, Toolbox Work Area).
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Creating a New Drive Configuration File
Refer to Figure 6-1, Block 3.

Refer to Appendix E, “Creating
an Innovation Series Drive”,
for detail on these procedures.

½  To create a new drive configuration file

1. Create a new drive (from the toolbox menu, select File and New).

2  Choose the appropriate pattern and version for the drive being started. If you
are not sure of which version, it is recommended to use the latest.

3. Verify the Intelligent Part Number (IPN) information, as shown in the following
sample screen. Enter changes, if required.

These numbers are used to set drive protection. Therefore, it is
extremely important that you enter these numbers correctly.

The drive IPN can be found
 on the data nameplate (inside
the drive door) or the drive
elementary.

Appendix A shows a sample
data nameplate.

Inverter
frame size

Inverter maximum
voltage rating

Product major
revision

Inverter’s
shunt rating
(recommended:
read directly
off shunt)

Refer to Figure 6-1, Blocks 5
and 6.

All procedures in this section
were completed successfully
for:
     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3

Checking Toolbox/Drive Pattern Compatibility
The firmware pattern used to create the .icb file must be the same version as the
pattern loaded in the drive (the DSPX board). If it is not, then either the flash code
(which contains the pattern version) must be downloaded from the toolbox to the
DSPX, or the .icb file must be upgraded.

½  To check the directory for the pattern versions available for
commissioning

1. From the toolbox menu bar, select File then Open.

2. Check under the GE Control System Solutions / Innovation Series
Drive directories for the patterns.

Pattern numbers
(these may vary
according to the
system)

Note  The toolbox requires the pattern directory to be located under the exact struc-
ture of GE Control System Solutions / Innovation Series Drive. If this exact
directory structure is not present, you must correct it.
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½  To install the latest pattern version

1. Connect to the drive (DSPX) by selecting the Go on/offline button .

2. Select OK after verifying the file and drive name.

The toolbox now attempts to connect to the drive. It compares the pattern revision
used to create the .icb file with the pattern version loaded into the DSPX.
A patch difference in version will allow connection, but a major or minor differ-
ence will not. For example:

Pattern version:   V01.   19    03      A
 Major        Minor Patch Release

If connection (communication) is not allowed because the differences are major, the
toolbox will display a message.

If the pattern is compatible, the pattern displays in the Summary View of the toolbox
main screen. The following sample shows equivalent patterns in the file and the
drive.

3. If a pattern difference is indicated, you should do one of the following:

• Download new drive firmware if the drive is older than the file

• Upgrade the file if the file is older than the drive

• Or download older drive firmware

For procedures, refer to Downloading to the Drive and Optional: Upgrading the
.icb File in this chapter.
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Refer to Figure 6-1, Block 6A. Downloading to the Drive
½  To download the firmware pattern from the toolbox to the drive

1. Select the Device menu and Download to Drive.

2. From the flyout menu, click on a selection and then Yes.  A downloading
message then appears and the drive resets after the download completes.
Download the files in this order:

a. Pattern Flash (Runtime)

b. DDI Runtime

c. Parameter Values

d. Keypad (DDI) Menus

Refer to Figure 6-1, Block 6B.

All procedures in this section
were completed successfully
for:
     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3

Optional:  Upgrading the .icb File
Associated with the pattern version in the drive are parameters that vary, depending
on each application. These parameters are stored in the .icb file.

Tip ©  .icb files are typically stored in a project directory. To establish the default
directory from the toolbox, select Options, Settings, and the tab Directories.
Then from the Default Project text box, select the browse button to find (for exam-
ple) C:\Jobs\GESalem\JobName\ISD1.icb.

The revision of the pattern used to create the .icb file must be the same as the firm-
ware revision loaded into the DSPX. To achieve this, it may be necessary to upgrade
the .icb file to a more recent version. The toolbox can automatically upgrade older
.icb files to newer revisions.

See Appendix E, “Upgrading a
Configuration” and “Select
Upgrade Version,” for addi-
tional information.

½  To upgrade the .icb file from the toolbox

1. Open the .icb file by selecting File, Open, and the correct file (for example,
ISD1.icb).

2. Check the version (refer to the following section, Checking for Correct Hard-
ware and Software). If the file needs to be upgraded, select File then Upgrade.

3. Select Yes to proceed with the upgrade.

The toolbox now displays the version or versions to be upgraded.

Note  If the version required does not appear, it needs to be installed from the
Control System Solutions CD.
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4. Click the version desired, then select OK.

5. To check for any errors generated, select the Validate Selected button .

The toolbox status bar should display the message:

Validation complete with 0 errors and 0 warnings – SUCCESS

Otherwise, review messages for the appropriate action.

6. If the version of runtime code in the DSPX needs to be updated, then the firm-
ware must be downloaded to the flash PROM.

7. Since the parameters have also been updated, they should be downloaded to the
drive.

Tip ©  If these drive parameters are considered correct, you can make a backup
copy that is stored in the DSPX board. To do this, select Device then Save the Pa-
rameter Values to the Backup Copy. If needed, this backup can be used in
place of repeating steps 1 through 7.
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Checking for Correct Firmware and Hardware
Refer to Figure 6-1, Block 7.

All procedures in this section
were completed successfully
for:
     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3

Typically, firmware and hardware revisions are backward compatible with older
revisions. However, occasionally the firmware depends upon a minimum revision of
hardware. The release notes (RelNotes.txt, provided with the toolbox files; refer to
Figure 6-3), provide an overview of the drive hardware and software relationship.

½ To determine correct hardware and software

1. From the toolbox, select Help, Release Notes, and Innovation Series
Drive.

This displays the versions of drives you have (for example, Innovation Series
ACCBN-A Low Voltage Non-Regen DC Source, V02.19.00B).

Note  In older versions of the toolbox (before Version 6), this Help feature did not
exist. However, the Notes.txt file was provided in each drive firmware pattern
directory. You can view this file with any text viewer.

2. Select the applicable version to display the RelNotes.txt file. Within that file,
check and make note of the following information:

• Critical Hardware Requirements details board version requirements

• Dependencies details software version requirements

Drive version and hardware
information can also be viewed
from the keypad

3. Within the toolbox, select View, Reports, Drive Version and Hardware
Information.

Note  You must be connected to the drive to do this.

This displays a drive information screen.

Sample toolbox screen
showing drive
information.

This should be
compatible with the
information in the
RelNotes.txt file.

4. Check that the drive information displayed matches the Critical Hardware
Requirements and Dependencies of the RelNotes.txt file. If hardware is
different, contact GE (refer to Chapter 1). If software is different, update it using
the instructions in this chapter’s Checking Toolbox/Drive Device Pattern
Compatibility section.
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Drive Control Pattern and Boot Monitor
The drive control processor board (IS200DSPX)  can be loaded with one
of several different control patterns, which are based on the  drive
product type (such as ACDCF-G, ACDCF-S, ACCBR-S, ACCBN-S).
Multiple releases of each product type are typically available on the
Control System Solutions CD.  These releases are identified by version
numbers, such as:

ACDGF-G, V01.36.04C
ACDGF-G, V01.38.00C
ACDGF-G, V02.14.00C

Each drive product release contains the following components:
- DSPX controller boot monitor
- Firmware (flash) pattern

The drive product type and revision that is present in the DSPX processor
can be determined from the keypad General Setup menu, or from the
toolbox menu bar, selecting View, Reports, Drive Version, and
Hardware Information.

Drive Control Hardware
Control board hardware revisions exist for
each board in the drive.  Some control
features in the software may be dependent
upon minimum revisions of hardware.

Such dependencies are outlined in the
toolbox RelNotes.txt  for each drive
product type.

GE Control System Toolbox
The toolbox is installed on a PC connected to
the drive serial port.

The toolbox is released periodically with new
features and enhancements.  These releases
are identified by the Toolbox Version (for
example, V06.00.14C).

The toolbox version can be obtained from the
Help toolbar, About Toolbox selection.

Drive Configuration File (*.icb)
The drive pattern must be configured for each application.
Configuration parameters can be stored in a file (*.icb) with the
toolbox.  The revision of this file must match the revision of the pattern
loaded into the drive DSPX.

The version of the drive configuration file is displayed in the toolbox
Summary View.

Drive Keypad (DDI)
- DDI firmware version
- DDI alternate language file

The DDI revision that is present in the
keypad  can be determined from the keypad
General Setup menu, or from the toolbox
View  toolbar, Reports pick.

Drive Power Bridge
The drive configuration is dependent upon
the power bridge design.  Critical design data
must be entered into the drive configuration
file’s IPN data to ensure proper protection of
the drive  power bridge.

- Product type and version
- Drive size (frame)
- Voltage rating
- Current feedback shunt size
- Other critical drive setup data

This data can be found on the drive’s IPN
(included on the drive Data Nameplate).

Control System Solutions
This CD contains the GE Control
System Toolbox and all files
necessary to configure the drive.

Serial Port
Connection

(or via ISBus)

The drive contains multiple components that may be revision sensitive.

Figure 6-3.  Drive Hardware and Software Overview
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Checking the Keypad (DDI)
Refer to Figure 6-1, Block 8.

All procedures in this section
were completed successfully
for:
     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3.

The operator interface located on the control cabinet front door is the Drive Diag-
nostic Interface module (DDI, most commonly called keypad).

1. Observe that the display’s heartbeat icon is pulsing (refer to Figure 6-4). This
indicates that the keypad can communicate with the drive. (The cable from the
keypad connects to the rack’s J10 connector.)

Note  If the keypad’s display cannot be read or contrast is poor,  refer to Adjusting
Keypad Display Contrast in the following section before proceeding to step 2.

2. If faults were present, use toolbox Help (select Help, Product Help, Con-
tents, Faults) or refer to the drive Reference and Troubleshooting publication
(listed in Equipment/Material Needed in this chapter) for information.

The keypad and toolbox screens presented in this document are
samples that represent one possible drive application. The
screens for your drive should display information that is
specific to your configuration and application.

Using the Keypad for Startup and Commissioning
The keypad can be used to check firmware and hardware versions, run the drive
commissioning and autotune wizards, set drive parameters, reset the drive, and pro-
vide many other functions to control the drive. This information is provided in the
drive User’s Guide GEH-6392.

Heartbeat Icon
(Animated)

Run (Green)

Stop (Red)

Status screens provide
both analog and digital
representation of drive
functions and values.

Menu screens provide
text-based access to
parameters, wizards,
and faults.

Display:

Pushbuttons:
Organized into
functional groups:
  Navigation buttons
for using the menu

Drive Control buttons

Run and Stop buttons

Reset
Faults

Remote
Local

Jog

Speed

Drive Controls

Status

Menu

EnterEscape

Navigation

RPM feedback
        0.0 RPM
Motor current
        0.00 A rms
Motor voltage
        0.00 V rms
Motor power
        0.00 KW

GE Innovation Series�

-150 0% +150

0%

0%

+150

+150

+150-150 0%

75

75 Drive Health
& State Icons

Figure 6-4.  Front View of the Keypad
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Adjusting Keypad Display Contrast
You can improve visibility of the keypad display by adjusting the contrast. This can
be done using either the keypad (refer to GEH-6382) or the toolbox.

½  To adjust keypad display contrast using the toolbox

You should not see “Offline” on
the toolbox status bar (bottom
right side of screen).

1. Check that the drive is online (the Go on/offline button  is selected).

2. In the toolbox work area (see Figure 6-5), expand the items displayed in the
Outline View by clicking on the plus sign next to Main Menu, General
Setup, Keypad, and Keypad Meters.

3. Double-click Keypad contrast adj to display the associated Edit Parame-
ter dialog box.

4. The dialog box displays the value Range for this parameter. In the Value text
box area, enter a number, then click Send To Drive and OK.

5. Reset the drive as shown below, which resets the display to the new value.

Toolbox menu
bar selections.

6. If the display is still not readable, contact GE Product Service (see Chapter 1,
How to Get Help).
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Select and double-click to display
Edit Parameter dialog box.

New value entered for keypad display
contrast (must be within Range)

Display contrast range

Figure 6-5.  Toolbox Work Area and Dialog Box for Keypad Display Adjustment
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Commissioning the Drive
Commissioning is the final stage of starting up a drive lineup. This process is most
easily achieved by using the toolbox wizards, but can also be run from the keypad.

Typically, the source is commissioned first, then each inverter separately. The wiz-
ards must be run in the following order:

1. Commissioning (source and inverters)

2. Cell Test (source and inverters)

3. Motor Control Tuneup (inverters)

4. Speed Regulator Tuneup (inverters)

Overview of Drive Parameters/Wizards
Appendix E describes use of the
wizards.

During initial commissioning, the drive (source or inverter) must be configured to
meet the requirements of the specific application. This is done by adjusting parame-
ters. The most commonly used parameters have been assembled into step-by-step
wizards to facilitate quick and complete drive configuration. These wizards can be
run from either the toolbox or the keypad.

Note  The procedures in this chapter are based on running the wizards from the
toolbox. However, the guidelines should still apply to wizards run from the keypad.

The drive Commissioning wizard must be run on every new configuration. After the
initial configuration, use of the drive Commissioning wizard is optional, but still
recommended. Other wizards are available to automatically tune drive regulators
(such as Motor Control or Speed Regulators) and speed specific startup tasks (such
as Panel Meter Setup and Ground Fault Detection).

The wizards lead the user through critical setup parameters and calculate internal
settings. Because the wizards actually run in the drive processor (the toolbox must be
online with the drive), the calculations will result in differences in the drive. These
changes should be saved in the .icb file by uploading the parameter values from the
drive to the toolbox (refer to Optional: Uploading the .ICB File in this chapter).

To access the block diagrams,
select “Diagram” from the
toolbox work area, outline
view.

After the Commissioning wizard is run, parameters may be adjusted individually
from the toolbox menus, the block diagram, or the keypad. Changing parameter
values while the drive is running is not recommended, although some parameters,
such as diagnostic setups, can be adjusted with minimal risk while running.

Some parameters should only be changed when the drive is stopped because they
trigger rules, or calculations, in the drive processor. The toolbox does not allow
these parameters to be downloaded to the drive while it is running, and will notify
the user that the parameter requires rules to be run.
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The keypad accepts the new value for these type of parameters while running, and
notifies the user as follows:

Error starting Rules Calc for Parameter
   Press any key to Continue

This is an indication that the user should stop the drive for the rules to run, allowing
this change to take effect.

To reset the drive from the
toolbox, select the Device
menu, then Reset Drive and
Hard Reset.

Some parameters require a hard reset in order to perform the calculations. The
toolbox does not allow these parameters to be downloaded to the drive while it is
running and notifies the user that this parameter requires a reset to take effect. The
toolbox or keypad automatically resets the drive when these parameters are sent to
drive.

The keypad does not accept the new values for these type of parameters while run-
ning, but notifies the user as follows…

No Hard Reset for Parameter While Drive Running
   Press Any Key to Continue.

This message indicates that the user should stop the drive to make this change.  If
this change is made while the drive is stopped, the toolbox and the keypad automati-
cally reset the drive.
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The drive “Reference and
Troubleshooting” documents
(listed in the “Tools/Materials
Needed” section) also contain
the wizard descriptions.

For an online description of the toolbox wizards specific to your drive, select Help,
Product Help, and Wizards.

Viewing Parameter Differences

Having the pattern versions loaded equally into the file and the drive does not mean
that the parameters in the toolbox and the drive are equal.

If the parameters in the toolbox are not equal to what is in the drive, a not equal sign
≠ displays in the Status bar at the bottom of the toolbox window. To display the dif-
ferences, double-click on the not equal sign ≠. This causes the toolbox to compare
the parameter values with those in the drive.

The toolbox parameters must be equal to the drive parameters before the wizard can
be run. The wizard will request either an upload or a download.
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Calculate Parameter Final Values

Final values are calculated from parameters. These values are present in the drive,
but are not normally viewable in the toolbox unless they are overwritten. The ≠ sign
at the bottom of the pattern screen does not include final values. The toolbox indi-
cates that overrides exist in the pattern by displaying a red O at the bottom of the
screen.

The wizard uses the parameter settings that were entered to calculate the parameter
final values. If parameter final values are overridden, running the Wizard will not
update these values.

Privilege levels provide differ-
ent types of access to the
 devices.

Level 4 allows changing
parameters and editing hard-
ware, and requires a password.

½  To view and clear overrides with Level 4 privilege

1. From the toolbox, select the Finder button , then Overrides and
Update.

2. Double-click on the item selected.

3. Select Clear then Override.

4. Select Device, Reset Drive, Hard Reset.

Overrides are typically not required and should be avoided.
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Refer to Figure 6-1, Block 9.

All procedures in this section
were completed successfully
for:
     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3

Running the Commissioning Wizard
Step through this wizard using the procedures below. Set the parameters according
to the application, using the elementary data sheet as an aid.

Note  Running the wizard overwrites values in the drive. Be sure to make backups if
the data in the drive should be saved before proceeding.

Some items are only available
with Level 4 permission.

½  To run the Commissioning wizard

1. From the toolbox, select the Wizard button . This displays the Choose
Wizard screen with a list of the wizards available for that drive type.

Sample toolbox screen
showing wizard selection
for source.

The Commissioning and
Cell Test wizards must be
run on the drive at initial
startup and commissioning.

The other wizards are
contained within the
Commissioning wizard and
do not need to be run
separately. They are
provided to facilitate
specific configuration
activities.

Sample toolbox screen
showing wizard selection
for inverter.

The "Required" wizards
(Commissioning, Cell Test,
and Tuneup) must be run
on the drive at initial startup
and commissioning.

The other wizards are
contained within the
Commissioning wizard and
do not need to be run
separately. They are
provided to facilitate specific
configuration activities.

Note  In older versions of the toolbox, wizard names were preceded by either a nu-
meral or an alphabetic character to indicate whether the wizard was included within
the Commissioning wizard. Refer to Appendix E for an example.
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2. Select the listed Commissioning wizard. A series of screens display for you to
verify or enter information about the drive and system you are commissioning.

The Commissioning wizard will guide you through the critical and most com-
mon configuration parameters.

3. Complete all screens as directed by the Commissioning wizard.

Note  If a previous .icb file was not present and this file was created by selecting the
default Choose Pattern and Version, then the Commissioning wizard displays
default values and/or No Values. These then need to be set according to the
application.

Tip ©  If this is the first time running the wizards for this drive, you may want to
select Simulator Mode when that wizard screen appears.

Click the Help button on each wizard screen for information about the selections and
requirements of that screen.
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Refer to Figure 6-1, Block 10.

All procedures in this section
were completed successfully
for:
     � source      �  inverter 1
                           �  inverter 2
                           �  inverter 3

Running the Cell Test Wizard
The Cell Test wizard checks for proper dc bus charging. It also tests for short circuits
in bridge devices and for opens in the bridge and motor circuits. During the test, the
drive bus is charged.

½  To run the Cell Test wizard

1. The drive doors must be closed to and the drive re-energized.

To prevent potential electrical hazard to personnel, proper
re-energizing procedures must be strictly followed.

2. Clear all faults.

3. Check that the Test Stop switch is operational.

4. Check that the following conditions are true (these are required to run the Cell
Test wizard):

a. Dc bus fully charged

b. System and local permissive satisfied

c. Safety grounds (that were applied for test) removed and doors closed

d. Blowers or fans on

e. Drive not in simulator mode

f. No faults shown on the keypad’s fault display (such as ac line fuse failure)

5. From the toolbox, select the Wizard button , then select and run the Cell
Test wizard.

If a failure occurs, the possible affected devices display on the keypad.

6. When exiting the Cell Test wizard, make sure that the toolbox and the drive are
equal. If not, do an upload, as described previously.
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The Trend Recorder is an op-
tional add-in to the toolbox and
is installed separately from the
“Control System Solutions”
CD. You can then open the
Trend Recorder from within the
toolbox.

Optional:  Using the Trend Recorder to Observe
Cell Test
The Trend Recorder enables you to graphically observe and record drive signals as
the cell test runs. If a cell fails the test, you can use the Trend Recorder data for
troubleshooting. (See Using the Trend Recorder Online Help.)

½  To run the Trend Recorder during cell test

1. From the toolbox main menu, select the Trend Recorder button . This
displays the Trend Recorder menu buttons and a window showing the default
signal selection.

2. Add any signals that you want to observe by selecting the Trend Recorder’s +
button and adjust the graphical display as desired).

3. Turn the Trend Recorder on by selecting the Record button , then run the
Cell Test wizard, observing the display (refer to Figure 6-6).

4. Select the Record button  to stop the recording.

Drive Control Window
Animated Bar Graph Display

Cell Test Wizard Display,
Cell Test Running

Trend Recorder WindowLegend and Digital Values Graphical Values

Figure 6-6.  Sample Toolbox Display of Trend Recorder, and Drive Control
Windows While Running Cell Test Wizard
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GE document GEH-6408
 contains the same information
provided in the Help files.

Using the Trend Recorder Online Help

The Trend Recorder online Help feature provides detailed information about using
the program.

Note  Because the Trend Recorder is an add-in option to the toolbox, its Help files
are not included as part of the toolbox Help. You must have the Trend Recorder
installed and open to access its Help files.

To access this screen, you must have the Trend
Recorder open with the Trend Recorder menu bar
displayed. From there, select  Help  then
Contents.

Displays an organized list of Trend
Recorder help topics, matching its
user document GEH-6408.

Displays an alphebetized list of
toolbox help topics.

Allows you to search for a Help
topic by entering a word into a text
box.

Doubleclick an open-book icon  to
hide topics listed under that
heading.

Doubleclick a question icon to
display help information for the
topic beside it.

Doubleclick a closed-book icon  to
display topics listed under that
heading.
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Refer to Figure 6-1, Block 10.

All procedures in this section
were completed successfully
for:
     �  inverter 1
     �  inverter 2
     �  inverter 3

Running the Tuneup Wizards (Inverters Only)
As a final step of commissioning the drive, you must run the Required wizards for
the inverters. These wizards tune the motors to the drive.

From the Choose Wizard screen (refer to Running the Commissioning Wizard), run
the following wizards, completing the screens as directed:

1. Motor Control Tuneup

2. Speed Regulator Tuneup

3. Check the keypad display for fault indication. (The keypad’s fault display pro-
vides a description of this fault.)

For an online description of the drive faults and possible solutions, select Help,
Product Help, and Faults. These descriptions are also included in the drive
Reference and Troubleshooting documents (listed in the Tools/ Materials
Needed section of this chapter).
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Notes
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Appendix A   Understanding
Equipment Drawings

Introduction
GE document GEH-6390 con-
tains outline and layout draw-
ings for the Innovation Series
low voltage drives.

GE drawings are an important source of information to help the customer success-
fully install and maintain the drive. These drawings provide an electrical and me-
chanical representation of the drive equipment as it applies specifically to the
customer’s installation. This includes layout, mounting, wiring, and interconnection
information, provided as outline drawings, panel layouts, and elementary dia-
grams.

For each customer requisition, GE assigns unique identification numbers to the
equipment and associated drawings. These numbers are included on the equipment’s
data nameplate, and are structured to provide information about the equipment.

This appendix defines content and numbering conventions used on drawings for GE
drive systems. The purpose is to help the customer more effectively use the docu-
mentation provided. This section is presented as follows:

Section Page

Data Nameplate....................................................................................................... A-1
Identifying the Equipment ...................................................................................... A-2

Equipment Catalog Number ............................................................................ A-2
Intelligent Part Number ................................................................................... A-3

Drawing Numbers................................................................................................... A-3
Outline Drawings.................................................................................................... A-4
Panel Layout Drawings........................................................................................... A-4
Elementary Diagrams.............................................................................................. A-4

Equipment Reference Information................................................................... A-4
Elementary Drawing Number.......................................................................... A-5
Wire Number Identification............................................................................. A-5

Conventions Used with Other Equipment............................................................... A-6
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Data Nameplate
The data nameplate is located on the back of the cabinet door. Figure A-1 shows a
typical data nameplate found on a lineup, a cabinet (panel)/case, and a core unit of a
drive system.

Note  When contacting the factory for assistance, provide the requisition number
and cabinet or core module’s ML and serial number printed on the nameplate.

DATA NAMEPLATE

REQ# F47DP702560               ITEM# 100
ML# 3VXMJ610PR007              SERIAL# NNXMJ610PR007001
1ST PRESS         IPN#ACDCF-G-0620-575-0400-BBH-AABAD-AB
DRAWINGS: ELEM: 259B3196AA OUTL: 259B3196AE

LAYO: 259B3196AP
INST:

VOLTS 894   (V) VOLTS 575   (V)
AMPS  537   (A) PWR AMPS  490   (A)PWR

IN HERTZ DC    (HZ) OUT POWER 490   (KVA)
PHASE       (PH) FREQ 9   TO 90  (HZ)

3 PH. ROTATION CCW
OVRLD CAP 125 %, 60 SEC SERVICE FACTOR 1.00
MOTOR FIELD: VOLTS, AMPS
MAX. SYM S.C.C.: AMPS AT VOLTS MAX
NEMA SERVICE CAT: NEMA ENCL TYPE
FREQUENCY TOC 507  AMPS. 180 SEC
VOLTAGE TOC MIN.LEV. 355 AMPS
VOLT UNBAL AMB.COMP.

Requisition
Number

Material List
Number

Associated
Drawings and
Instructions

Serial Number– Shop order
& date code for GE factory
identification

Power Application
Data

Item Number

IPN – Intelligent Part No.
identifies drive configuration

Figure A-1.  Typical Data Nameplate

Identifying the Equipment

Equipment Catalog Number
The data nameplate provides
the ML number.

Each GE lineup, cabinet (panel)/case, and core unit has a unique identifying catalog
number, also called the part or material list (ML) number. This number is struc-
tured to provide information about that equipment (see Figure A-2.) The catalog
number links the equipment to its requisition, drawings, components, materials,
specification item, and shipping documents.

Unit & sequence number of components:

    CA## = Case assembly

    CD## = Core dc drive controller

    CI### = Core ac drive controller

    LU### = Lineup, multiple case

    assembly

    PN## = Panel assembly

    RL## = Requisition-level assembly

###XX3V AAA 123

Sequence/project

Order month/year/
product line

Identifies manufacturer as GE Industrial
Systems, Salem, VA

Unique
to req’n

Figure A-2.  Sample Drive Catalog (ML) No.
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Intelligent Part Number
The elementary and data
nameplate provide the IPN
number.

The Intelligent Part Number (IPN) defines the drive configuration, independent of
requisition requirements (this number is not unique for each customer order). It is
structured so that the Base number indicates the drive type (for example, dc-fed ac
drive), while additional digits identify other features (see Figure A-3). The Base and
Frame digits together make up the Device ID, which is used in the system firmware.

The IPN is found on the system elementary, and may also be included on data name-
plate.

ACDCF -G-0125 -0575 -0100 -AAA-AABAC -BAA[AA]

Base

Regulator

Frame

Voltage

Current

Basic Options

Group 1
Options Group 2

Options

Device ID Category 2 Options

Release

Figure A-3.  Intelligent Part Number Structure

Drawing Numbers
For each customer requisition, GE assigns a unique drawing number. The number is
structured to provide information about the drawing itself, as well as the equipment it
defines.

Each drive frame size has a
standard elementary, outline,
and layout drawing. The secon-
dary suffixes for these are E, O,
and L to identify the drawing
type.

(See Figure A-4.) The basic drawing number is an 8-digit structure (seven numerals
and one alpha) for each drawing size. A double-alpha suffix is added to the end of
the basic number to indicate the equipment category and drawing type.

Q = Level 2 computer dwg.
T = Misc. equipment
V = MCC coordination dwg.
X = Operator station
Z = General

Original drawing
Size:  A, B, C, or D

CA9999B229

Basic number

Secondary suffix -- drawing
type:

A = Elementary diagram
C = Customer terminal board
E = Outline (mech. dimension)
G = Misc. customer info.
J = Oneline
L = Operator station layout
P = Factory assembly print

Primary suffix -- equipment category:

A = Main drive
C = Adjustable voltage drive
E = Automation
G = Main power conversion
J = Application engr. dwg.
M, N, P = Motor control center (MCC) & ac power distrib.

Figure A-4.  Sample Requisition Drawing Number
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Outline Drawings
GE document GEH-6390 pro-
vides drive outline drawings.

An outline drawing is a physical representation of the equipment to be furnished. It
includes equipment dimensions, openings, weights, and heat losses. This information
is essential when installing the drive.

A typical drive outline drawing provides the following views of the equipment:

• A front view, showing physical arrangement of the drives with panel dimensions

• An end view, showing floor sill location and general dimensions

• Bottom and/or top plan, showing conduit access areas and any other information
needed to connect to or locate the equipment

Panel Layout Drawings
GE document GEH-6390 pro-
vides drive layout drawings.

A panel layout is a type of assembly drawing. It shows:

• Device locations

• Wiring paths

• External wireways/cableways

• Terminal board numbers and points

• External connection points to panel devices, and associated drive/case numbers

System Elementary Diagrams
A system elementary is requisi-
tion-specific. The contract
documents define distribution
of these drawings.

A drive elementary is specific to
the drive. GEH-6390 provides
drive elementaries.

A system elementary diagram (elementary) is a partial electrical representation of the
equipment as applied to the customer’s application. It references all control devices
supplied by GE under a particular requisition, unless otherwise defined. The system
elementary’s drawing number ties it to the requisition (see Figure A-4).

A system elementary is developed from the engineering design database and me-
chanical motor list. The drawing includes the internal and external connections
required to complete the electrical system. It indicates interconnections to the
equipment using slash marks and level identifications.

Equipment Reference Information
The front sheets for each system elementary diagram (the “Drive 0” sheets, see sec-
tion A-7.2) provide reference information for the equipment, such as:

• Cover sheet with customer name, requisition number, and other job information

• List of related elementaries

• Index

• GE equipment reference information

• Elementary diagram practices/symbols

• Typical equipment grounding practices
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Elementary Drawing Number
System elementaries show the
requisition-specific drive
application data.

Drive elementaries show the
drive configuration and general
application information.

A system elementary diagram number consists of the basic number (refer to Draw-
ing Numbers), plus additional digits that identify the drive.

(See Figure A-5.) Functional drive numbers (1 – 999) subdivide elementary dia-
grams. These are denoted in the sheet number. For example, sheets 3AA, 3AB, and
3AC apply to drive 3; sheets 100AA, 100AB, and 100AC apply to drive 100. In
general, those sheets show the wires and functionality of the panel(s) assigned this
drive number.

239B9999AA

Drawing Number

SH. NO.
100  AG

Drive Number

Sheet Number

Figure A-5.  Sample of Drawing Sheet Number

Each elementary diagram reserves Drive 0 for front sheets (for example, sheets
0AA, 0AB, 0AC). These contain reference information.

Note  GE does not intentionally duplicate drive numbers in any one project.

Wire Number Identification
Wires are labeled in the drive and on the elementary diagram with the same identi-
fying number. The wire number specifies the location of its connection within the
elementary.

(See Figure A-6.) Internal and external wire numbers are structured to identify the
elementary diagram sheet number, plus the grid block (line number and column al-
pha) on the sheet where the wire originates. For example, wire number 100AA20B
originates on sheet 100AA, line 20, column B. If a second wire originates on line 20
of sheet 100AA, it must initiate in a different vertical column.

Line number coordinate

100AA 20 B

Column alpha coordinate

Sheet number

Figure A-6.  Sample Wire Number
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Conventions Used with Other Equipment
Note  Different documentation conventions are used with other types of equipment.

An Innovation Series drive system may incorporate equipment manufactured by
other GE and vendor companies. Typical examples are the ac motor control center
(MCC) and the Genius™ and Field Control™ I/O systems.

These companies use different conventions for their drawings. For their application,
installation, capability, and wiring information, see the instruction manual for those
products.
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Appendix B   Cable Separation and
Routing

Introduction
This appendix should be used to
check for proper cabling after
the equipment is installed, but
before beginning startup.

Cables that carry signals and power are categorized into four defining levels:  low,
medium, high, and power. Each level can include classes.

Electrical noise from cabling of various voltage levels can interfere with microproc-
essor-based control systems, causing the drive to malfunction. This appendix pro-
vides recommended cable separation practices to reduce electrical noise. The
information is presented as follows:

Section Page

Low-Level Signals (Level L)...................................................................................B-2
Medium-Level Signals (Level M)............................................................................B-2
High-Level Signals (Level H)..................................................................................B-2
Class Codes..............................................................................................................B-2
Cableway Spacing Guidelines .................................................................................B-3

General Cableway Spacing...............................................................................B-3
Tray/Tray Spacing ............................................................................................B-4
Tray/Conduit Spacing.......................................................................................B-4
Conduit/Conduit Spacing..................................................................................B-5

GEH-6380 provides cabling
guidance for preparing the in-
stallation site for the drive.

The recommended practices in this appendix are consistent with the installation
guidance provided by document GEH-6380, Installation Guidance for Innovation
Series Drive Systems.

Note  If a situation at the installation site is not covered in this document, or if these
guidelines cannot be met, please contact GE before installing the cable.
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Low-Level Signals (Level L)
These signals consist of:

• Analog signals 0 through ±50 V dc

• Digital (logic-level) signals less than 28 V dc

• 4 – 20 mA current loops

• LAN signals, such as ISBus, Profibus, and Genius

• Signal commons ACOM, DCOM, CCOM, and SCOM

Medium-Level Signals (Level M)
These signals consist of:

• Analog signals greater than 50 V ac with less than 28 V ac ripple

• 28 V dc light and switching circuits

• 24 V dc switching circuits

• PCOM, SHCOM

High-Level Signals (Level H)
These signals consist of:

• Dc switching signals greater than 28 V

• Analog signals greater than 50 V dc with greater than 28 V ac ripple

• Regulating signals 50 V with currents less than 20 A

• Ac feeders less than 20 A

Power (Level P)
Power cabling carries ac and dc buses 0 – 800 V with currents 20 A – 800 A.

Class Codes
Certain conditions can require that specific wires within a level be grouped in the
same cable. This is indicated by following class codes, defined as follows:

   S Special handling of specified levels can require special spacing of conduit
and trays. Check dimension chart for levels. These wires include:

• Signals from COMM field and line resistors

• Signals from line shunts to regulators

   U High voltage potential unfused wires over 600 V dc

 PS Power greater than 800 V dc and/or greater than 800 A

If there is no code, there are no grouping restrictions.
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Cableway Spacing Guidelines
Spacing (or clearance) between cableways (trays and conduit) depends on the level
of the wiring inside them.

General Cableway Spacing
General spacing practices apply to all levels of cabling. They should be used  with
the specific spacing values in Tables B-1 through B-3.

• All cables of like signal levels and power levels must be grouped together in ca-
bleways.

• In general, different levels must run in separate cableways, as defined in the dif-
ferent classes. Intermixing cannot be allowed, except as noted by exception.

• Interconnecting wire runs should carry a level designation.

• If wires are the same level and same type signal, group those wires from one
panel to any one specific location together in multiconductor cables.

• When unlike signals must cross in trays or conduit, cross them in 90° angles at a
maximum spacing. Where it is not possible to maintain spacing, place a grounded
steel barrier between unlike levels at the crossover point.

• When entering terminal equipment where it is difficult to maintain the specific
spacing guidelines given in Tables B-1 through B-3, keep parallel runs to a
minimum, not to exceed 5 ft in the overall run.

• Where Tables B-1 through B-3 show tray or conduit spacing as 0, the levels can
be run together. Spacing for other levels must be based on the worst condition.

• Trays for all levels should be metal and solidly grounded with good ground con-
tinuity. Conduit should be metal to provide shielding. (Use Table B-1 for non-
metal conduit/tray spacing.)

• When separate trays are impractical, levels L and M can combined in a common
tray if a grounded steel barrier separates levels. This practice is not as effective as
tray separation, and may require some rerouting at system startup. If levels L and
M are run side-by-side, a 1-inch minimum spacing is recommended.

• Locate levels L and M trays and conduit closest to the control panels.

• Trays containing level L and level M wiring should have solid bottoms and be
covered to provide complete shielding. There must be positive and continuous
cover contact to side rails to avoid high-reluctance air gaps, which impair
shielding.

• Trays containing levels other than L and M wiring can have ventilation slots or
louvers.

• Trays and conduit containing levels L, M, and H(S) should not be routed parallel
to high power equipment enclosures of 100 kVA and larger at a spacing of less
than 5 ft for trays and 2 1/2 ft for conduit.

• Level H and H(S) can be combined in the same tray or conduit, but cannot be
combined in the same cable.

• Level H(S) is listed only for information since many customers want to isolate
unfused high voltage potential wires.

• Do not run levels H and H(S) in the same conduit as level P.
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• Levels H and P can be run in a common tray if levels are separated by a barrier.
This barrier does not have to be grounded. Spacing should be for level P.

• Where practical for level P and/or P(S) wiring, route the complete power circuit
between equipment in the same tray or conduit. This minimizes the possibility of
power and control circuits encircling each other.

Tray/Tray Spacing
Table B-1 defines the recommended minimum distance between trays:  the top of
one tray and the bottom of the tray above, or the sides of adjacent trays. Table B-1
also applies if the distance is less than 5 ft between trays and power equipment up to
100 kVA.

Table B-1.  Spacing* Between Trays

Level L M H H(S) P P(S)

L 0 3 6 6 26 26
M 3 0 6 6 18 26

H 6 6 0 0 4 12

H(S) 6 6 0 0 8 18

P 26 18 4 8 0 0

P(S) 26 12 12 18 0 0

*Spacing is in inches

Tray/Conduit Spacing
Use Table B-1 for tray/conduit spacing if:

• Trays or conduit are non-metal

• Levels L and M trays are not covered (Table B-2 assumes levels L and M trays
are covered)

• If the distance is less than 5 ft between trays or conduit and power equipment up
to 100 kVA

• Table B-2 lists the minimum recommended distance between the outside surfaces
of metal trays and conduit.

Table B-2.  Spacing* Between
Metal Trays and Conduit

Level L M H H(S) P P(S)

L 0 1 4 4 18 18
M 1 0 4 4 12 18

H 4 4 0 0 4 8

H(S) 4 4 0 0 6 12

P 18 12 4 6 0 0

P(S) 18 18 8 12 0 0

*Spacing is in inches
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Conduit/Conduit Spacing
Use Table B-1 for conduit/conduit spacing if:

• Conduit is non-metal

• Distance is less than 2.5 ft between conduit and power equipment rated up to 100
kVA

Table B-3 lists the minimum recommended distance between the outside surfaces of
metal conduit run in banks.

Table B-3.  Spacing* Between
Metal Conduit Runs

Level L M H H(S) P P(S)

L 0 1 3 3 12 12
M 1 0 3 3 9 12

H 3 3 0 0 3 8

H(S) 3 3 0 0 6 9

P 12 9 3 6 0 0

P(S) 12 12 6 9 0 0

*Spacing is in inches
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Notes
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Appendix C   Printed Wiring Board
Reference

Catalog (Part)
Number. Board/Module Description (Function) Publication

IS215ACL_ Application Control Layer GEI-100434

IS200ALSA AC Line Snubber GEI-100257

IS200ATBA Application Terminal Board GEI-100284

IS200BAIA Basic I/O GEI-100268

IS200BICL Bridge Interface GEI-100264

IS200BPIA Bridge Interface GEI-100265

IS200BPIB Bridge Interface GEI-100266

IS200CAPB Control Rack Backplane GEI-100270

IS200DAM_ Gate Drive/Amplifier Interface   GEI-100262

IS200DSFC 1000/1800 Frame IGBT Gate Driver/Shunt Feedback GEI-100263

IS200DSPX Digital Signal Processor GEI-100267

IS215GBIA Genius Interface Module   GEI-100269

IS200HFPA High Frequency Ac/Fan Power Supply GEI-100255

IS200ISBB ISBus Bypass Relay GEH-6410

IS200ISBD ISBus Delay GEH-6410

IS200ISBE ISBus Extender GEH-6410

IS215PBIA ProfiBus Interface Module GEI-100419

IS200RAPA Control Rack Power Supply GEI-100261

IS200RCSA 1800 and 1000 Frame Snubber GEI-100303

IS200RCSB 620 Frame Snubber GEI-100295

IS200SCNV SCR/Diode Converter Interface GEI-100280
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Notes



GEH-6388  Installation and Startup Appendix D   Pre-Startup Checklist  •  D-1

Appendix D   Pre-Startup Checklist

Transformer
� Transformer instruction manual present

� Transformer of correct rating and mounted correctly

� Proper grounding installed

� Power cables meet requirements and are installed

� Transformer overtemperature (if supplied) correctly
interfaced

� If transformer is oil-filled:  Sudden pressure relay
installed and tested, liquid level and pressure relief
operational

Drive Software
� Toolbox (drive configuration) software available

� Drive configuration pattern present (xxx.ICB file)

� Correct version of drive firmware available and
installed

� Correct version of keypad firmware available and
installed

� Motor data nameplate

Drive Hardware
� Drive elementary drawings supplied and up-to-date

� Drive cabinets mounted correctly to floor

� Drive lineups properly secured together at lineup
splits

� Case tie plates and brackets in place and secured

� DC bus tie splices Installed and tightened to the
proper torque

� Protective ground tie plates in place

� Drive equipment protective ground properly attached
to ground grid with separately run CCOM ground

� Power cables meet requirements, and are installed

� Drive room has adequate cooling

� Drive source fusing correct

� Shunts sized correctly

Motor
� Motor of correct rating and mounted on base

� Motor properly grounded

� Power cables meet requirements and are installed

� Motor shaft ground brush correctly mounted

� Motor has sufficient cooling

� Optional:  motor tachometer mounted
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Appendix E   Configuring an
Innovation Series Drive

Introduction
This appendix is a duplicate of
Chapter 4 of GEH-6401,
“Control System Toolbox for
Configuring an Innovation
Series Drive”.

This appendix provides instructions for using the toolbox to configure and monitor
an Innovation Series drive. It also contains information on using other features of the
toolbox specific to the drive.

Section Page

Creating an Innovation Series Drive ........................................................................E-2
New Drive.........................................................................................................E-2
Pattern and Version...........................................................................................E-3
Verify the Drive IPN ........................................................................................E-3
Enter User Identification...................................................................................E-4

Configuring the Drive ..............................................................................................E-5
Toolbox Work Area..........................................................................................E-5
Enter Job Specific Information .........................................................................E-7
Upgrading a Configuration ...............................................................................E-7
Select Upgrade Version ....................................................................................E-8

Working with Files and Menus................................................................................E-9
File Types .........................................................................................................E-9
Pattern Files ....................................................................................................E-10
Opening and Closing Files..............................................................................E-10
Saving Files ....................................................................................................E-10
Exporting Configuration Files ........................................................................E-11
Exporting/Opening Project Files ....................................................................E-11
Menu Commands............................................................................................E-12

Concepts ................................................................................................................E-18
Configuration.........................................................................................................E-19

Parameters ......................................................................................................E-19
Toolbox/Drive Communications ....................................................................E-21
Communication Settings in a Second Drive ...................................................E-22

Block Diagram.......................................................................................................E-24
Links to Other Pages.......................................................................................E-25
Modify Parameters from Diagram..................................................................E-25
Parameter Jumpers..........................................................................................E-26
Live Data Display ...........................................................................................E-26
Drag-and-Drop Variables ...............................................................................E-27
Printing Diagrams...........................................................................................E-28

Drive Controls........................................................................................................E-29
Wizards ..................................................................................................................E-30

Choose Wizard ...............................................................................................E-30

The information in this appendix
is also available in the toolbox
Help files.
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Creating an Innovation Series Drive
When the toolbox starts, the toolbox Work Area displays (refer to the section
Configuring the Drive). The Work Area is used to maintain the drive configuration
file in the toolbox. You must create a new drive configuration file (.icb) or open an
existing one.

Or choose the New
button.

½  To create an Innovation Series drive

w From the File menu, choose New. The New dialog box contains all installed
toolbox products. Choose the drive as follows:

Click on the tab,
Drives & Exciters.

Click on Innovation
Series Drive and
click OK.

The New Innovation Series Drive dialog box displays to allow you to choose the
pattern and version.

New Drive

Choose this option to
display the pattern and
version directory dialog
box and manually load
the desired product
(pattern).

Choose this option to go
online and automatically
determine the pattern
and version.
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Pattern and Version
Choose the Pattern and Version displays the followings dialog box and allows
you to choose the Pattern name and Version directory.

Pattern (product)

Version

1. Click on the desired Pattern (product) and click  to expand the pattern list
and display Version numbers.

2. Choose a Version from the list and click OK. The Verify the Drive IPN
(Intelligent Parts Number) dialog box displays.

Verify the Drive IPN

Verify these numbers
from the cabinet Product
Data nameplate, located
inside the cabinet door.
Enter the correct
numbers, as necessary.
Click OK.To avoid equipment damage,

the IPN must match the IPN on
the cabinet Product Data
nameplate.
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Enter User Identification
To view these configuration
changes with User ID, choose
the View menu and Reports.

If the Enter - ID dialog box (shown below) displays, you must enter an ID to
identifies the user about to make changes to the configuration.

You must enter a three character ID
(such as your initials).

If you are the only user making
changes with the toolbox, you can
permanently avoid this dialog box by
entering your ID. Choose the Option
menu, Settings, and the tab General.

Enter your three
character
identification.
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Configuring the Drive
The Toolbox Work Area is the main screen of an Innovation Series drive
configuration (see screen below). This area is used to configure the drive. Across the
top of this screen is the Title Bar, which contains the name of the toolbox and the
name of the file (drive configuration) in use. Under the title bar is the Menu Bar
containing all available menu commands. These commands are described in the
section, Working with Files and Menus.

Toolbox Work Area

Tip ©  To expand or collapse an item in the Outline View, use the mouse and click
on  .  Or, use the left and right arrow keys to expand/collapse the list. To navigate
through the items in the hierarchy list, use the up and down arrow keys.

Menu Bar

Summary View - This area displays detailed
information for each item in theOutline View and
Diagram drawings.

Outline  View

Items under
Main Menu
can vary with
each
configuration.

Log
View

Status bar

Toolbar

Titlebar
The Detached Summary
View displays Diagram.)

Once a new drive is created (or a file is opened), the Outline View displays the drive
name and two items; Main Menu and Diagram.

The default device name is ISD1.
Additional new devices are incremented
by one. This name should be modified
to more accurately refer to the drive
being configured. The name is limited to
five characters
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½  To modify the drive

1. Click on the drive name to highlight it.

2. From the Edit menu, choose Modify.

The Edit Innovation Series Drive dialog box displays and allows you to edit
drive properties as follows:

Modify Drive Properties
Drive Name is used as identification when
communicating with the System Database
(SDB). Enter up to five characters.

Verify and enter the
correct numbers from the
cabinet nameplate
located inside the cabinet
door.

Choose the network
interface for this drive,
such as ISBus.

Serial Port is the default
communications setting.

To connect to Ethernet, you
must enter the IP address
of the controller or the ACL
to be used as a bridge to
the drive.

Click to edit the Intelligent
Part Number (IPN).
To avoid equipment damage,
the IPN must match the
number labeled IPN# on the
cabinet nameplate located
inside the cabinet door.
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Validating the Drive
Also, any items in the hierarchy
that had problems during
validation will display red after
the validation.

Or click .

Validation checks for errors that might prevent successful operation of the drive. If
the configuration needs to be validated, the Outline View displays the items in red.

½ To validate the drive configuration

w From the Drive menu, choose Validate.

The validation results display in the Log View at the bottom of the toolbox Work
Area.

Enter Job Specific Information
Each wizard dialog box
contains a Help button.

Once a new drive has been created and the properties are modified, you must enter
job specific data, such as motor hp, motor amps, and motor speed. This information
can be entered in a new configuration using the menus or the Drive Commissioning
Wizard (refer to the section Wizards). A wizard is an interactive Help utility that
guides the user through each step of a particular task, such as drive commissioning.

Tip ©  If the drive contains a different pattern than the one presently being
configured, it is necessary to first download the new pattern. Refer to the section
Upgrading a Configuration. The toolbox will recognize this condition and notify the
user if it is a problem.

½ To configure the drive online

Each configuration depends on
application requirements. For
more information, contact
Product Service Engineering at
+ 1 800 533 5886 or Fax at
+ 1 540 387 8606 (replace +
with the international access
code).

1. From the toolbox, click  to go online.

2. From the Edit menu, choose Wizards.

3. Choose the Drive Commissioning Wizard.

Note  Entering the Drive Commissioning wizard information and performing the
applicable tuneups should be sufficient to configure the drive for basic operation.

4. From the Device menu, choose Download to Drive and Parameter
Values.

Note  If an alternative language for the keypad is desired, choose Device menu,
Download to Drive, and DDI Menu.

Upgrading a Configuration

Refer to GEH-6401, Chapter 3,
Using the Toolbox.

The upgrade command adds the required functions of a newer version of the pattern
to the current drive configuration file (.icb). For example, the current drive
configuration file (.icb) is version V01.19. The application requires the functions of
version V01.21.00C. Upgrade the drive configuration file as follows:

½  To upgrade a file

1. Make sure the new required version is installed (refer to Chapter 3).

2. From the current drive configuration file (.icb), such as version V01.19.03C
described above, choose the File menu and choose Upgrade. The following
message box prompts to proceed you with the upgrade.
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Click Yes to upgrade
the drive.

Select Upgrade Version
If you select to upgrade the drive, the Select Upgrade Version dialog box
displays all newer installed versions.

Select the required
version.

The following message displays. These items can be downloaded from the Drive
menu. Refer to the sections, Configuring the Drive and Download To Drive.
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Working with Files and Menus
An Innovation Series Drive is configured using different types of files, which are
described in the following sections. Menu commands are also described.

File Types

Back up all files often to
avoid loss of data.

The configuration files generate output that can be downloaded to the drive.

Configuration files include:

Drive configuration file (.icb) is a binary working file that contains an exact copy
of the drive configuration used by the toolbox. Users generally work from drive
configuration files. When the file is saved, the prior .icb is renamed to an .ibb file
and used as a backup file. To restore the backup copy, rename the file to a .icb file.

Tree files (.tre) are text files that serve several purposes. Some define the
parameters, faults, menus, and other items that exist within a particular drive. Others
store configurations for transport between different drives, and possibly different
versions of the toolbox.

Project files (.prj) are text files that hold some drive configuration information. They
are used, in conjunction with other tree files, to transport configurations across
versions of drive patterns, and possibly different versions of the toolbox.

Note   The .tre and .prj files are not normally used by users.

Output files include:

Drive Diagnostic Interface (DDI) database files (.icd) describe the configuration
for the DDI(also known as keypad). This file is downloaded to the drive.

Database Computer

SDB

New

Export/Import

* .icb f ile

Print

Update SDB

Pattern configuration files

Windows NT or Windows 95
Running Toolbox

Programmer Workstation

Open

Save

Documentat ion

Download Pattern
Upload/Download
Parameters

Block & Network (.TRE)
prj. (project file)
  and .tre files

The .prj files (OPEN/EXPORT)
list all .tre files that should be
imported for this file.

Create

Active
Parameters

Backup
Parameters

Restore

Save

Innovation Series Drive
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Pattern Files
The pattern is loaded into the
drive processor, which resides
on the DSPX board. The DSPX
board is located in the drive
control rack.

The drive can be loaded with different patterns. The term pattern is used to describe
the functionality that can be loaded into a drive. For example, a drive can be loaded
with a general industry pattern or a system pattern. A pattern is defined with the
following collection of files used by the toolbox:

Tree files (.tre) are text files that contain configuration information for the pattern.

Runtime files (.arc) are binary files that contain the runtime image that is
downloaded to the drive.

Diagram files (.wmf) are drawing files that contain the toolbox block diagrams.

Help files (.hlp) provide pattern specific help from within the toolbox.

Upgrade files (.dll) are binary files that provide an intelligent pattern specific
upgrade from previous pattern versions.

Opening and Closing Files
Opening an drive configuration file (.icb) reads a previously saved drive
configuration into the toolbox.

½ To open a file

Or choose the  Open
button.

1. From the File menu, choose Open. The Open dialog box displays.

2. Choose the file name and click OK.

Check the Release Notes
located in the toolbox Help
menu under About Toolbox.

Note If an older version toolbox is used to open a drive configuration file (.icb) that
was saved with a newer version, a Warning box is displayed. Either install the
version of toolbox that the drive configuration file (.icb) was saved with (listed in the
Warning box) or consult the toolbox Release Notes to see if they are compatible.

½ To close a file

w From the File menu, choose Close.

Closing a file removes the configuration from the toolbox. If the configuration has
not been saved, a dialog box displays and asks if the configuration should be saved.

Saving Files

Or choose the  Save
button.

Saving a file writes the entire contents of the configuration to a drive configuration
file (.icb). The prior drive configuration file (.icb) is renamed to a .ibb file and used
as a backup file.

½ To save a file

1. From the File menu, choose Save. The Save As dialog box displays.

2. Enter the file name and click OK. (Once a configuration has been saved, the
Save button saves the new file without asking for a file name.)

Tip ©  The Save button also indicates that a change was made to the configuration
by highlighting (red) and becoming enabled. If the computer or toolbox fails when
the button is red, all changes since the last save is lost, so save files often.
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Exporting Configuration Files
The .tre files can be exported
selectively or for an entire
drive. Refer to the next section
Importing/Exporting.

The parameter values contained in a drive configuration file (.icb) can be exported in
a .tre file format. Exporting drive parameters allows settings among drives to be
shared.

½  To export parameter values

1. From the File menu, choose Export, then choose Parameter Values. The
Parameter Value File Name dialog box displays.

2. Confirm the current project directory/file name or choose a new directory. The
file is saved as a .tre file.

Exporting/Opening Project Files

This option is normally not required, but is
provided if a newer version of the toolbox makes a
change to the format of the drive configuration file
(.icb) that is not backward compatible.

Normally, newer versions of the toolbox can load drive configuration files created by
older versions. However, if a major change in functionality of the toolbox occurs, the
toolbox may not be able to load the drive configuration file. In this case, it is
necessary to first export the drive configuration file to a project file and then import
it into the new version of the toolbox.

Project files save the drive configuration in a form that can be loaded by all newer
versions of the toolbox.  A project file (.prj) is a text file, which contains the names
of all .tre files in a configuration. Project files allow the user to export and import a
drive configuration without having to know about all the files it contains.

½ To create a project file

1. From the Outline View, choose the drive name or the desired item.

2. From the File menu, choose Export and choose either Selected Item (exports
just the .prj file) or All Export Code (exports all .tre files and the .prj file).

Once a project file exists, it can be used to create a drive configuration file (.icb).
From the file Open command, choose a .prj file. This creates an Innovation Series
drive and starts a series of file imports. The toolbox imports the files listed in the .prj
file, including the parameter values file.
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Menu Commands

File Menu
The File menu allows you to perform file operations with the following commands:

Or click

Or click 

New creates a new drive configuration file.

Open loads an existing drive configuration file into the toolbox.

Close exits an existing drive configuration.

Or click 
Save/Save As saves an opened drive configuration file to a specified name.

Or click 
Import retrieves values from the specified file. The values in the current
configuration are replaced with the imported values.

Export sends specified items (such as parameters and files) to a designated file.

Upgrade automatically makes the required changes to upgrade an older pattern and
its configuration to a new version.

Print Setup allows the user to choose a printer and printer connection.

Tip ©  The block diagram is designed to print best in Landscape Orientation. Refer
to the section Block Diagrams/Printing Diagrams.

Or click 
Print provides a paper (hard) copy of a specified file or page.

Print Preview displays the page as it would be printed.

Mail To opens email and provides a copy of the currently opened file to send (you
must have Window messaging, such as Exchange).

File 1, 2, 3...  lists and opens the most recently used files.

Exit closes the toolbox.



GEH-6388   Installation and Startup Appendix E   Configuring an Innovation Series Drive  •  E-13

Edit Menu
The Edit menu allows you to edit items with the following commands:

Modify allows you to edit the highlighted item.

Or click 
Cut removes the highlighted item and places it on the clipboard.

Or click 
Copy duplicates the highlighted item and places it on the clipboard.

Or click 
Paste places the highlighted item from the clipboard into the current file.

Or click 
Wizards allow you to choose from a list of wizards used for drive configurations
commissioning, tests, and tune-ups.

Or click 
Bookmarks enable you to mark major items in the Outline View and then return to
them easily using the menu command Goto Next Bookmark.

Options Menu
The Options menu allows you to manage general options for toolbox operation.

Settings allow you to set general toolbox options.

Privilege sets the privilege level for a session.

Passwords set the password for a privilege level.

Logout User closes the current user from the current session and sets the privilege
level back to 0.



E-14  •  Appendix E   Configuring an Innovation Series Drive Innovation Series Low Voltage Drives   GEH-6388

View Menu
Some of these commands can
be toggled on and off. A check
mark (á) displays next to the
command name when the
feature is on and it will display
in the toolbox.

The View menu allows you to manage the drive with the following commands:

Toolbar displays or hides the Toolbar.

Status Bar displays or hides the Status bar.

Or click 
Tracking toggles the tracking feature of the Summary View on and off.

Close Outline reduces the hierarchy list of items displaying in the Outline View to
just the drive level.

Or click 
Detached Summary creates a detached window of the Diagram View.

Or click 
Zoom In enlarges the view of the block diagram area (Summary View).

Or click 
Zoom Out reduces the view of the block diagram area (Summary View).

Or click 
Finder starts the Finder view to search text.

SDB Browser starts the SDB Browser window to search the System Database
(refer to the manual, GEI-100271).

Or click 
Trend Recorder starts the Trend Recorder application (refer to the manual, GEH-
6408). Choose Tile Horizontal or Tile Vertical from the Window menu to view both
the Trend Recorder and toolbox Work Area simultaneously (or use <Ctrl>< Tab> to
toggle between screens).
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Or click Drive Control starts the Drive Controls view, which can be used to start and stop
the drive. It also provides specific information, such as motor speed, volts, amps and
power.

Drive Fault List displays a list of all active faults and alarms. Each fault is time
stamped so that the order of events can be determined.

Reports contain the following options:

Compare Parameters To Drive produces a report that shows all
parameters whose values in the toolbox are not the same as in the drive.

Compare Drive Parameter Values to Backup Copy produces a
report that shows the difference between the currently active parameter and
the backup copy.

Override List displays a list of settings in the drive that are overridden
from their manually calculated state.

Drive Version and Hardware Info produces a report that shows the
version of the drive pattern and bar code information of the boards installed
in the control rack.

Parameter Values displays all parameters and their values in a menu
hierarchical structure.

Change History produces a report of changes made to the drive
configuration file.
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Device Menu
The Device menu allows you to manage the drive with the following commands:

Or click 
Validate makes certain that drive configuration does not contain errors.

Or click 
Online/offline toggles to start or end communications between the toolbox and the
current drive.

Or click 
Download to Drive sends the following data:

Parameter Values sends the values of all the parameters from the loaded
drive configuration files to the current drive.

DDI Menus sends the menu structures and other data to the Drive Diagnostic
Interface (DDI; also known as the keypad). This is only required when an
alternative language is desired.

Pattern Flash sends the drive firmware configuration to the current drive.

Upload Parameter Values from Drive reads all the parameter values from the
current drive and provides the option of replacing the values in the currently loaded
drive configuration file in the toolbox.

Reset Drive has two commands:

Hard Reset initiates a hard reset of the current drive.

Clear Faults resets all faults that are currently active in the drive.

Put into Database puts information into the SDB to allow drives to share signals
with other drives and controllers on the network. This command can be enabled if a
network is enabled.

Save the Parameter Values to the Backup Copy saves the current set of
parameter values in the drive to a permanent storage backup copy in the drive that
can be retrieved later.

Restore Parameter Values from the Backup Copy allows you to restore the
backup copy of parameter values previous saved.

A check (á) displays by the
command when the buffer is
enabled.

Capture Buffer Enable toggles a high speed buffer, which can capture data in the
drive. The contents of the capture buffer can be viewed using the Trend Recorder.
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Window Menu
The Window menu arranges multiple views of open documents in the drive window
with the following commands:

Cascade arranges the windows in an overlapped style.

Tile Horizontal arranges the windows horizontally in non-overlapped tiles.

Tile Vertical arranges the windows vertically in non-overlapped tiles.

Arrange Icons arrange the icons of closed windows.

Close All closes all open windows.

Help Menu
The Help menu has the following commands:

Contents displays Help files for the toolbox. It also contains the Find tab with a
work list to search for specific topics.

Using Help displays general instructions on how to use Help.

Item Help displays help for the item selected in the Outline View.

Product Help displays the Help file for the currently loaded pattern. The file
contains help on parameters, faults, diagrams, and wizards.

About Toolbox displays the version number of the toolbox.
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Concepts
The following section defines items and features used when configuring an
Innovation Series drive. When a drive is created, the Work Area displays as follows:

The drive name can
be modified.

Main Menu contains
the configurable items.

Click here to display
a drawing of the block
diagrams and signal flow.

Parameters allow you to configure the drive behavior. Each parameter has a name
with up to 20-characters, which identifies it and helps to convey its use.  A parameter
also can have units, such as RPM, displayed with the toolbox and keypad. The unit
field is limited to five characters. Each parameter contains a value, which can be a
number or a setting. The value is adjusted in order to modify the drive behavior.
Some basic parameters along with their associated units are: Motor rated current
(Amps), Motor rated freq (Hz), Motor rated voltage (Volts), and Regulator type.
Parameters can be set and modified from the Outline View under the items Main
Menu or Diagram, or from a Wizard or keypad.

Rules process inputs from parameters and produce values for other parameters that
the user does not normally edit. The rules in an Innovation Series drive are run in the
actual drive. The toolbox initiates the rules in the drive and uploads the resulting
values from the drive.

Variables, similar to parameters, have a 20-character name and a 5-character unit
field. However, unlike parameters, the user cannot change variables. They are
changed by the drive as a result of the execution of the pattern within it. For
example, the variable Speed feedback (RPM ) gets updated on a continuous basis and
represents the drives actual speed.

Drive Diagnostic Interface (DDI) menu structure in the toolbox represents the same
information contained on the DDI (keypad) located on the front of the drive. The unit
allows the user to set, monitor, and maintain the drive.

Diagrams provide an overall picture of signal flow, sequencing and regulator control
in the drive. While communicating with the drive, the diagrams display drive
variables and their real time values.  Contact and coil states are also indicated.
Certain drive parameters can be modified from this view (refer to the section Block
Diagrams).

Backup/Restore Parameters
A backup/restore function is provided within the drive and can be initiated from
either the toolbox or the keypad.  There are two areas of non-volatile RAM in the
drive, which support this function.  Each of these areas contains a complete set of all
the drive parameter values.  This allows you to save the active set of parameter
values so that they can be restored later.  This feature is particularly useful if
undesired changes are made to a functioning drive and it becomes necessary to
restore the backup copy.

Note  This feature does not restore different versions  of the pattern to the working
copy. Rather it rewrites the active set of parameter values with the backed up set of
parameter values.
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Configuration
Parameters

For detailed information about
a parameter, click on the
parameter (to highlight it) and
press F1.

The drive contains a set of parameters whose values, together with the pattern and
version, define the drive behavior. In the Outline View of the toolbox, parameters
display as follows:

½  To modify a parameter

Use the Finder to easily locate
a specific parameter.

1. From the Outline View, click on the parameter to modify.

2. Choose the Edit menu and choose Modify.

 Or, double-click on the parameter. The Edit Parameter dialog box displays
(refer to the next section).

Tip ©  If you know the name of the parameter (or partial name) choose the Finder
and enter the name in the text box. Click Find and a list of parameters and variables
display. Double-click on the parameter/variable to modify.
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Edit Parameter

This button is enabled if
the parameter is a selector
type parameter (used  to
select a variable).

Click to display the
detailed Help for this
parameter.

Click to send the new
value to the drive.

This button may not be
enabled for all parameters.
It allows you to change the
display units usually
between metric and U.S.
units. This button only
effects the displayed
values and not the drive
control.

The new value displays under
the field Drive Value.

Enter a new value (within the range) or choose
a value from the drop-down menu. Then, click
Send to Drive for the value to take effect.

Enter a note for this
parameter, if desired.

Note  When a parameter value is edited, you must Send To Drive to take effect.

Click this tab to search
for a variable by name.

Enter any part of the
name in this text box
and click Begin Search.
Click an option button to
specify the exact
location for the search.

Click this tab if you do not know any part of the
variable. All variables for this configuration are listed.
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Toolbox/Drive Communications
The toolbox can communicate with the drive through a serial port connection. The
serial port connection settings used by the toolbox can be defined and modified.
These settings are saved and used by the toolbox for every connection to a drive
whose drive configuration file is set to communicate serially.

½  To modify the communications setting

1. From the Options menu, choose Settings.

2. Click on the tab, Innovation Series Drive.

3. Modify the Serial Port Communications settings, as desired.

Settings

Note  Depending on the products installed, all of the following tabs may not be
available.

This option changes the
names used on the
diagrams and Outline View
to internal names used
mainly by firmware
developers. It should not
be checked.

Check this option to
program the keypad with
an additional language.
You are prompted for the
language when the
Download to Device and
Keypad menu is chosen.

If you check this option and
choose to go online, the
Device ID Verification
dialog box displays with
identification information
for the toolbox and the
device. It is normally
checked.

Click on the drop-down box  to choose the
communication port.
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Communication Settings in a Second Drive
The toolbox allows you to have more than one drive configuration open at the same
time. If you have more than one serial port in your computer, you can also be online
with more than one drive.

½  To modify communication settings in a second drive

From Outline View, click on the
drive name with the right mouse
button. The following pop-up menu
displays.

Choose Communication Settings.
The Serial Port Settings dialog box
displays. Modify the settings for a
second drive, as desired.

Note  This change is temporary and not saved between uses of the toolbox.

Serial Port Settings

Use this option to overwrite
the default Comm port when
using a second drive.

For diagnostic purposes only.

Download To Drive
If the toolbox is not online, you
will be asked to confirm that
you want to go online and then
download. The download
performs and the drive resets.

The toolbox allows you to download parameter values, keypad menu structures, and
pattern flash (runtime) to the current drive.

½  To download to the drive

1. From the Device menu, choose Download.

2. Choose Parameter Values, DDI Menus, or Pattern Flash (Runtime).
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Upload Parameter Values
Parameter values can be uploaded from the drive to the toolbox. This can be
necessary after an autotune or when values in the drive were modified using the
keypad. The toolbox reads all values from the drive and compares them to the values
in the toolbox. A list of differences is generated and allows you to select the
parameters to upload.

½  To upload parameter values

1. From the Device menu, choose Upload Parameter Values from Drive.
The drive values are read and compared to the toolbox, and a list displays the
differences.

2. From the list, select the parameter values to copy to the drive configuration in
the toolbox by clicking on the checkbox beside each parameter name.

3. Click OK. The selected parameter values replace the values in the toolbox.

Reset Drive

A hard reset immediately stops all drive control
and disables all bridge output power.

A hard reset restarts the drive
in order to clear a fault
condition.

A hard reset takes about 15
seconds to complete.

The toolbox allows you to either perform a hard reset or just clear faults in the drive.
A hard reset has the same effect as cycling power to the drive. Clear faults resets
the fault list in the drive, except for faults that require a hard reset.

½ To hard reset the drive

w From the Device menu, choose Reset Drive and choose Hard Reset. A
message box indicates that a reset is in progress.

½  To clear faults in the drive

w From the Device menu, choose Reset Drive and Clear Faults.
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Block Diagram
In landscape, the long edge of
the paper is horizontal.

Diagrams provide an overall picture of signal flow, sequencing and regulator
control in the drive. While communicating with the drive, the diagrams display drive
variables and their real time values.  Contact and coil states are also indicated.
Certain drive parameters can be modified from this view

½  To access diagrams

w From the Outline View, click on the item Diagram.

• The Overview diagram displays in the Summary View, as follows:

Click Diagram to
view drive block
diagrams.

Click the various
link buttons in the
Overview diagram
to view details of
the block.

Use the scroll bars
to view the entire
Overview diagram.
Use the Print
command to print
the diagram.
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Links to Other Pages
Diagram provides links to other pages, which contain information on drive functions.

½  To access diagram links

w From the Summary View, place the mouse pointer over a link button, such as

 on the diagram.

When the pointer turns into a hand, click on the link button. Another diagram
displays with more details and links. An Index is provided, as shown below.

Modify Parameters from Diagram
Parameters can be modified from the Diagram. In the Diagram, the toolbox displays
parameter names in the color blue.

½  To modify a parameter

w From the block diagram, move the cursor over the parameter until it changes
into a hand. Click on the parameter. The Edit Parameter dialog box displays
(refer to the section Parameter Settings).
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Parameter Jumpers
In the Overview diagrams, parameter jumpers show how different paths of the block
diagram are connected together.

Live Data Display
If the toolbox is connected to the drive, all variables on the diagram display live
values. On the Status bar, the scan rate shows the time it takes to update all the
variables on the currently selected page.

Variables
Green values are valid numbers
received from the drive.

Variables can be monitored by the toolbox. Live values display in the color green.

Output Voltage
42.6 V ms

Live value

Animated Contacts and Coils
Various types of animated contacts are used in the block diagrams to show the
current state of drive sequences.
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Pointer Parameters on the Diagram
A pointer parameter is a special type of parameter that points to a variable. This
parameter has an additional associated value, which is the value of the variable it
points at. In the following example, the Man spd ref pointer is using the Analog
Input 1 to supply the reference value. The live value shown is the value on the
Analog input.

>
 
 

Analog Input 1
0.012 Volts

Man spd ref pointer

Pointer parameters can also be used with contacts. The following example shows the
Xstop request controlled by Digital Input 1 and the Run Request controlled by
Digital Input 2.

XStop request pointer

>
 
 

 Digital Input 1
Run request pointer

>
 
 

 Digital Input 2

Drag-and-Drop Variables
Variables in the block diagram can be copied to the Trend Recorder using the drag-
and-drop feature.

Click on 

Choose the Windows menu and
Tile Horizontal or Tile Vertical.

½  To drag-and-drop a variable in the Trend Recorder

1. From the toolbox Outline View, click Diagram to display the Overview
diagram in the Summary View.

2. Click the link buttons to locate the desired variable(s). The Diagram (Summary
View) becomes full screen.

3. From the button bar, click  to open the Trend Recorder.

4. Resize and move the Trend Recorder window so that it and the block diagram
can be viewed (using regular Windows features).

Tip ©  To view both the toolbox and the Trend Recorder, from the Window menu,
choose Tile Horizontal or Tile Vertical and adjust the size of the windows.

5. From the Diagram, place the mouse pointer over the desired variable.

6. When the pointer changes to a hand, press and hold the left mouse button. The
pointer changes to the drag-and-drop cursor.

7. Continue to hold the left mouse button down and drag to the Trend Recorder
window. At the Trend Recorder, the cursor changes to the drop pointer.

8. Release the mouse button and the variable will drop in the Trend Recorder.
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Printing Diagrams

Tip ©  The block diagram(s) is designed to print in Landscape Orientation. From the
File menu, choose Print Setup and click the option Landscape.

½  To print block diagrams

Or click 

1. From the Outline View, click the item Diagram.

2. From the File menu, choose Print. The Print dialog box displays.

3. Choose the number of copies to print and the page(s).

This field shows that there are 17
diagrams in this device.
Click OK to print all the diagrams
or enter the page number(s) to
print.

Tip © To print a single block diagram, link to that page, so that it displays on the

screen and click . Choose OK. Live data can be printed out on the single page,
if the drive is online.
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Drive Controls
The Drive Controls command enables you to operate the drive from the toolbox, as
though you were operating it directly from the keypad located on the cabinet door.
The variables that display are the same as those that display on the keypad.

Or click .
½  To display the Drive Controls view

w From the View menu, choose Drive Controls. The Drive Controls view
displays.

Click here to toggle the direction of the drive
(reverse resquest). The selected direction is shown
with an icon (refer to the next table).*

Click here to reset faults.

Click here to run the drive
in the selected direction.*

Stop command can be
used in Local or Remote
mode.

Click here to toggle the
mode of the drive between
local and remote. The drive
must be stopped*.

*Available in local mode
only.

Reset
Faults

Remote
Local

Jog

Speed feedback
          250  RPM

Motor current
          63.5  Arms

Motor Voltage
           31.1  V rms

Motor power
            0.0  KW

-150%        0         150%

0%             0         150%

0%             0         150%

-300%         0        300%

Drive Controls

Speed

L

Click here to decrease or increase the
Local Speed Reference associated with
the Run and Stop commands.*

Click here to Jog the drive
in the selected direction.*

Bar graphs provide feedback of the
current state of the device. Click on a
bar graph to edit a parameter.

The following icons display on the Drive Controls and represent the drive’s health or
state. The active function of an icon depends on which button is clicked on (as
described above).

Icon Function Indicates

Comm. OK The icon line is animated to show there is
communication between the toolbox and the
drive.

L  or  R Control State L = drive is in local mode

R = drive is in remote mode

Fault State Icon flashing = trip

Icon steady = alarm active

Forward

Reverse

Direction of drive motion that is currently
selected. (This does not necessarily match the
direction of motion as viewed from motor shaft.)

Motion Drive is running when the icon is animated in a
turning motion.
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Wizards
A wizard is an interactive Help
utility that guides the user
through each step of a
particular task, such as Drive
Commissioning.

The Wizard list can vary with
each pattern, but there is
always a Drive Commissioning
Wizard.

The Innovation Series drive contains wizards that guide you through the setup of a
drive. Wizards display a series of dialog boxes that prompt the user for drive
configuration information. This information is also used as a basis to perform
additional tests and tuneups on the drive.

Note  The Commissioning wizard should be the first step when setting up a new
drive.

½  To perform a wizard

1. From the Edit menu, choose Wizards, or click . The following list of
wizards displays.

2. Choose the desired wizard.

Choose Wizard

Drive Commissioning
wizards are numbered,
such as 1 through 4.

Wizards used for
diagnostic procedures
are lettered, such as
A through F.

Obtain interactive Help on
each field by clicking Help.

The following dialog box is an example of the Drive Commissioning Wizard. Enter
a value in each field that contains <no value>, unless you are instructed otherwise.
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Glossary of Terms

ACL_ board
IS200ACL_Application Control Layer board. This board contains the ACL
controller functions for the drive. Located in the drive control rack.

ACL controller
Application Control Layer controller. A form of the Innovation Series controller
hosted in the Innovation Series drive rack that performs job specific, outer layer,
drive control loops, and sequencing.

application software
Job-specific software resident in the drive, designed specifically for the customer’s
application.

ACOM
Analog common. Used to supply power and signals to all analog devices and
components fed by +50 and -50 V power supplies.

ATBA
IS200ATBA Application Terminal Board, used for customer and power I/O. Located
in the drive’s control cabinet.

attenuator
An electronic transducer, either fixed or adjustable, that reduces the amplitude of a
signal passing through it without causing significant distortion. (Opposite of
amplifier.)

baud
A measure of data transmission speed, representing the number of signal-state
changes per second. Named after French engineer B.M.E. Baudot.

bit
A contraction of binary digit. The smallest possible unit of information.

board
Printed wiring board.

CCOM
Control common.
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coaxial cable (coax)
A type of wire cable with a solid metal core surrounded by an insulator, a
combination shield and ground wire, and an outer protective jacket.

commissioning
Putting into service.

configure
To select specific options, either by setting the location of  hardware jumpers or
loading software parameters into memory.

connector
A device, either a plug or receptacle, used to terminate or connect cables.

control system
(Industrial.) A means of governing the starting, stopping, direction of motion,
acceleration, speed, and retardation of the moving member of any electric apparatus,
machine, or system.

control system toolbox
See GE Control System Toolbox.

DDI
See Drive Diagnostic Interface.

drive
(Industrial.) The equipment used for converting available power into mechanical
power suitable for operation of a machine.  (See control system.)

Drive Diagnostic Interface
The operator interface module located on the front door of the drive’s control
cabinet. Also called DDI or the keypad.

device
A configurable component of a process control system.

diagnostics
Software that checks drive hardware or software, providing error indications that
identify the type or location of malfunction.

elementary diagram
Also called elementary. A schematic drawing that represents the electrical wiring
and electrical connections of a device.

fault code
A number that represents a drive malfunction, such a warning or failure. The drive
controller automatically sends this code to the operator interface, such as the DDI
(keypad). Also see warning, failure, DDI.



GEH-6388   Installation and Startup Glossary of Terms  •  3

ferrite
A magnetic material that consists essentially of ferric oxide combined with the
oxides of one or more metals (as manganese, nickel, or zinc. It has high magnetic
permeability and high electrical resistivity. The high resistance makes eddy current
losses low at high frequencies.

Finder
A subsystem of the GE control system toolbox for searching and determining the
usage of a particular item in a configuration.

firmware
The set of executable software that is stored in memory chips that hold their content
without electrical power, such as EEPROM.

frame size
Size of drive cabinet, or cabinets. Determined by hardware components required for
power application.

Genius bus
GE Fanuc’s distributed network of intelligent I/O blocks.

GE Control System Toolbox
A Windows-based software package used to configure and perform diagnostics on
controllers and drives.

ground
An electrical path designed to disperse high-voltage electrical spikes, usually by
routing them to the earth.

grounding electrode
A conductor or group of conductors in intimate contact with the earth for the purpose
of providing a connection with ground.

jacket
The outermost layer of insulating material of a cable or conductor.

hardware (hard) reset
Reset generated by a hardware device, such as a pushbutton, rather than by a
software reset. Used to reset the drive boards, clear some faults, and allow certain
parameter changes.

hardwired
Refers to elements of a program or device that cannot be changed. Originally, the
term was used to describe functionality that was built into the circuitry (the wires) of
a device. Now, the term also is used to describe constants built into software.

health
A term that defines whether the drive is functioning as expected.



4  •  Glossary of Terms Innovation Series Low Voltage Drives   GEH-6388

heartbeat

Also know as SQE (signal quality error), a test between the transceiver and data
terminal equipment to check that the transceiver is still functioning.

heatpipe
A heat exchanger consisting of a pipe with an interior of capillary material and a
small amount of fluid in a partial vacuum. Heat is transferred by absorption at one
end of the pipe through vaporization of the fluid and its subsequent condensation at
the other end of the pipe.

IEEE
Institute of Electrical and Electronic Engineers. A United States-based society that
develops for electrical and electronic standards.

IGBT
Insulated-gate bipolar transistor.

initialize
To set values (addresses, counters, registers, and such) to a beginning value before
the rest of the processing.

Intelligent Part Number
See IPN.

inverter
A device for converting direct current into alternating current.

I/O
Input/output. Data flow into and out of a device, or the term for input/output
interfaces.

IPN
Intelligent part number. An alphanumeric part number for Innovation Series drives in
which the number structure and characters define the drive configuration and
application.

ISBus
A synchronous bus, serial communications system developed by GE for the
Innovation Series drive system LAN. Uses RJ-45 connectors and Category 5 cabling
with data transmission rate up to 5 Mbps.

keypad
See Drive Diagnostic Interface.

LAN
Local area network. A communications link that enables attached devices to
communicate with each other over a limited geographical area. A typical LAN
consists of peripheral devices and controllers contained in the same building, and
often on the same floor.
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layout drawing
A diagram showing the components of a panel (see definition), and their location and
connections.

LED
Light-emitting diode. Used as a visual indicator for a board or drive function.

line filter, ac
A filter that connects from ac line to ac line at the input of a power converter. The
filter consists of a series configuration of resistors and capacitors, which damps out
high frequency oscillations on the ac power line.

line reactor, ac
A device (such as a coil, winding, or conductor of small resistance) used to introduce
reactance into an alternating-current circuit. The purpose is to reduce system
harmonics and protect against utility switching transients from the switching of ac
power factor correction capacitors or other line transients

m
Milli. Alphabetic symbol for 1 thousandth.

M
Mega. Alphabetic symbol for 1million.

MB
Megabyte. 220 or 1,048,576 bytes.

Mb
Megabit. 220 or 1,048,576 bits.

megger test
A test of an insulation system by using a megohm meter (megger) to pass a high
voltage at low current through a device, then measuring resistance, usually in
megohms.

menu
A list of available software functions for selection of an operator, displayed on the
computer screen after a software program has been entered or a software selection is
made.

module
(Hardware) An electronic assembly of boards, components, or a combination of
these, that together perform a specific function.

(Software) A collection of tasks that have a defined scheduling period.

NEC

National Electrical Code. Electrical safety guidelines developed by the National
Fire Protection Association and adopted as a standard by the American National
Standards Institute (ANSI).
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NEMA
National Electrical Manufacturers Association. An organization that develops
standards for the electrical manufacturing industry.

network
A data communication system that links two or more computers and peripheral
devices.

noise
Electrical surges, spikes, or transients on transmission lines. Noise can cause slow or
immediate damage to sensitive electronic equipment.

non-regenerative
See regenerative.

OSHA
Occupational and Safety Health Act.  A federal job safety law, passed by the United
States Congress, to prevent employees from being injured or contracting diseases in
the course of their employment.

outline drawing
A drawing or diagram that shows the dimensions and non-detailed layout of a device
or equipment.

panel
The side or front of a piece of equipment on which terminations and termination
assemblies are mounted.

panel layout drawing
See layout drawing.

parameters
Adjustable software settings used to program and tune the drive. Parameter values,
together with the pattern and version, define the drive behavior.

pattern
Application firmware specific to each drive type, and represented by the first part of
the intelligent part number (see IPN.) For example, the pattern ACDCF-G is for an
ac drive, specifically a dc-fed inverter, used for general industry applications.

plug connector
An electrical fitting or termination assembly with contacts constructed to be
electrically connected to a receptacle connector by being inserted into the receptacle
connector. Also known as male connector.

power loss
Ratio of power absorbed to power delivered. Also called watt loss.

psi
Pounds per square inch. A measure of air pressure.
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PVC
Polyvinylchloride. A type of plastic used for cable jackets and wire insulation.

PWM
Pulse-width modulation. Pulse-time modulation in which the value of each
instantaneous sample of the modulating wave is caused to modulate the duration of
the pulse. Also called pulse-duration modulation.

reboot
See hardware reset and software reset.

receptacle connector
An electrical fitting or termination assembly with contacts constructed to be
connected electrically to a cable by the insertion of the cable’s plug connector into
the receptacle connector. Also known as female connector.

regenerative
Ability of a drive to return power from the motor armature to the ac line. Creates a
braking effect on the motor.

renewal parts listing
The Renewal Parts List (or Quotation) is a document that lists the parts of a complete
system. This list applies specifically to the equipment furnished on a customer’s
particular application (requisition) at the time of shipment. The document, provided
per contract specifications,  includes part numbers and descriptions, quantity used,
recommended spares to keep onhand, and normal delivery cycle for obtaining each
part.

requisition
A written request to buy something. GE assigns a unique number to each customer
requisition, which is then used to identify that equipment configuration with that
particular customer request or order.

safety ground
See equipment grounding conductor.

shield
A conductive sheath (usually metallic) applied over the insulation of a conductor or
conductors. See shielding.

shielded cable
Cable surrounded by a separate conductor (the shield) intended to minimize the noise
effects of internal or external electrical circuits.

shielding
Use of a conducting barrier between a potentially disturbing noise source and
sensitive circuitry. Shields are used to protect cables (data and power) and electronic
circuits. They may be in the form of metal barriers, enclosures, or wrappings around
source circuits and receiving circuits.
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shunt
A device having appreciable resistance or impedance connected in parallel across
other devices or apparatus, and diverting some (but not all) of the current from it.
Appreciable voltage exists across the shunted device or apparatus and an appreciable
current may exist in it.

software (soft) reset
Reset initiated by software input, rather than by a hardware device. Activated by a
serial input.

terminal board
A type of I/O connector in which individual wires from external components are
inserted into a connector point and are fastened by turning a screw on the connector.

terminator
A resistor that reflects cable signals. On coaxial cable bus networks, a terminator is
installed at each end of the cable, with one end requiring ground connection.

toolbox
See control system toolbox.

torque
Any force that acts to produce rotation. The measured ability of a rotating part, such
as a gear or shaft. Units of torque include the foot-pound (or pound-foot), inch-
pound, the dyne-centimeter, and the Newton-meter.

twisted-pair cable
Cable consisting of pairs of copper wire, surrounded by an insulator, and twisted
together in a manner that reduces capacitance.

watt loss
See power loss.

wizard
An intelligent menu that leads the operator through a series of parameter edits,
calculations, and command executions designed to accomplish a specific task.
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Index

A

ac input, 4-3
ACCBN-A, 1-4, 1-5
ACCBR-A, 1-4, 1-5
ACDCF-G, 1-4, 1-5
ACDCF-S, 1-4, 1-5
ACDCF-V, 1-4, 1-5
ADF, 3-4, 6-6

dc bus, 2-5, 3-4, 6-2, 6-6–6-7, 6-26
ADS, 3-2, 3-4, 6-6
airflow, 2-4, 2-8–2-12, 2-14, 2-16
ALSA, 4-3
ATBA, 3-6, 6-6
autotune, 6-17
auxiliary device feeder, 3-4

C

cable
conduit, 3-1–3-2, 3-7, 3-9, A-4, B-2, B-3

cabling, 1-5, 3-1, 3-2, 3-7, 3-9, 3-10
control power, 3-2, 3-4, 3-5, 6-2, 6-6
grounding, 2-5, 3-6, 4-2
metal-clad, 3-7
power, 1-4, 2-4, 3-1, 3-2, 3-4, 3-5, 3-7, 3-8, 4-1, 4-3–

4-5
shields, 3-6

CCOM, 3-2, 3-6, B-2
CE Mark, 3-2, 3-9
cell test, 6-20, 6-26, 6-27

Trend Recorder, 6-27, 6-28, E-14
clearance, 2-2, 2-4, B-3
commissioning, 6-1, 6-4, 6-8, 6-17, 6-20, 6-24, 6-29,

E-7, E-30
autotune, 6-17
cell test, 6-20, 6-26, 6-27
pattern, 1-4, 6-2, 6-8, 6-11–6-13, 6-22, E-3, E-7,

E-10, E-19, E-22
simulator, 6-25, 6-26
startup, 6-1, 6-4, 6-8, 6-17, 6-20, 6-24, 6-29
toolbox, 6-1, 6-4, 6-8, 6-17, 6-20, 6-24, 6-29,

E-7, E-30
tuneup, 6-1, 6-20, 6-29
wizards, 6-8, 6-17, 6-20, 6-22, 6-24–6-25, 6-29, E-13,

E-30
conduit, 3-1, 3-2, 3-7, 3-9, A-4, B-2, B-3
configuration, 3-4, 3-7, 3-8, 6-6, 6-8, 6-10, 6-11, A-5,

E-5, E-9–E-11, E-19

connections, 2-5, 3-1, 3-2, 3-10
ATBA, 3-6, 6-6

control power, 2-5, 3-1, 3-2, 3-4, 3-5, 3-10, 6-2, 6-6
ADF, 3-4, 6-6

dc disconnect:, 3-4
ADS, 3-2, 3-4, 6-6
auxiliary device feeder, 3-4
CPT, 3-4, 6-6
dc bus, 2-5, 3-4, 6-2, 6-6, 6-7, 6-26
dc disconnect, 3-4
disconnect, 3-2, 3-4
fusing, 3-4

control rack
ATBA, 3-6, 6-6

Control System Solutions, 6-9, 6-11, 6-13, 6-27
Control System Toolbox, 1-1, 6-2, 6-8, E-1
CPT, 3-4, 6-6

D

damage, 2-1–2-3, 2-5, 3-4, 3-9, 4-2, 4-3
dc bus, 2-5, 3-4, 6-2, 6-6–6-7, 6-26
dc-fed inverter, 1-4, 3-4
DDI
     keypad, 3-9, 6-13, 6-15, 6-17–6-20, 6-29, E-7, E-9,

E-16, E-18, E-22, E-29
dimensions, 2-4, 2-7, A-4
disconnect, 3-2, 3-4
download

flash, 6-11, 6-13, E-16, E-22
drawings

elementary, 1-5, 3-1, 6-3, 6-11, 6-24, A-1, A-3–A-5
layout, 2-1, 3-1, 3-3, 6-2, A-3, A-4
outline, 1-5, 2-1, 2-4, A-1, A-4
requisition, 1-5, 2-1, 2-3, 2-4, 3-4, 3-6, A-1–A-5

drive, 1-1
dc-fed inverter, 1-4, 3-4
frame, 1-4, 2-1
intelligent part number (IPN), 1-4, 6-2, 6-11, A-3, E-3
inverter, 1-4, 2-8, 6-2, 6-29
lineup, 1-1, 1-4, 2-1, 2-4, 2-5, 2-7, 3-4, 3-6, 6-20, A-2
pattern, 1-4, 6-2, 6-8, 6-11–6-13, 6-22, E-3, E-7,

E-10, E-19, E-22, E-30
regenerative source, 2-9, 2-11
source, 1-4, 4-4–4-6, 6-2

non-regenerative, 1-4, 2-9, 2-16
line filter, 4-4–4-6
reactor, line, 3-2, 3-4, 4-3, 4-6, 4-7

Drive Diagnostic Interface, 3-9, 6-17, E-9, E-16, E-18
DSPX, 6-7, 6-20, E-10
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Index—continued

E

elementary, 1-5, 3-1, 6-3, 6-11, 6-24, A-1, A-3–A-5

F

files
.icb, 6-10, 6-11, 6-13, 6-20, 6-25, E-2, E-7, E-9

filter, 4-1
firmware (pattern), 1-4, 1-5, 6-2, 6-8, 6-11–6-13, 6-15,

6-17, A-3, E-16, E-22
flash, 6-11, 6-13, E-16, E-22
frame, 1-4, 2-1
fusing, 3-4

G

ground brush, 4-2
motor, 4-2

grounding, 2-5, 3-6, 4-2
CCOM, 3-2, 3-6, B-2

H

handling, 1-1, 1-5, B-2
lifting, 2-1, 2-3, 2-4

heat loss, 2-4, 2-8
help, 1-2, 3-7, 6-3, 6-8, 6-28, E-10, E-17

Trend Recorder, E-14, E-27

I

I/O, 3-1, 3-7, 3-9, A-6
ATBA, 3-6, 6-6
connections, 2-5, 3-1, 3-2, 3-10
terminal board, 3-1, 3-2, 3-6, A-4

installation, 1-2, 1-3, 1-5, 2-1, 2-4, 3-1, 3-6, A-1
cabling, 1-5, 3-1, 3-2, 3-7, 3-9–3-10
conduit, 3-1, 3-2, 3-7, 3-9, A-4, B-2, B-3
heat loss, 2-4, 2-8
lifting, 2-1, 2-3, 2-4
mounting requirements, 2-1, 2-4, 2-7, 3-7, 4-1

airflow, 2-4, 2-8–2-12, 2-14, 2-16
clearance, 2-2, 2-4, B-3
dimensions, 2-4, 2-7, A-4
heat loss, 2-4, 2-8
layout, 2-1, 3-1, 3-3, 6-2, A-3, A-4
weight, 2-2, 2-4, A-4

safety ground, 6-26
unpacking, 2-3

intelligent part number, 1-4, 6-2, 6-11, A-3
inverter, 1-4, 2-8, 6-2, 6-29
IPN, 6-2, 6-11, A-3, E-3

isolation transformer, 3-6, 4-5

K

keypad, 3-9, 6-13, 6-15, 6-17–6-20, 6-29, E-7, E-9,
E-18, E-22, E-23, E-29

L

layout, 2-1, 3-1, 3-3, 6-2, A-3, A-4
LEDs, 6-6–6-8
lifting, 2-1, 2-3, 2-4
line filter, 4-4–4-6
lineup, 1-1, 1-4, 2-1, 2-2, 2-4, 2-7, 3-4–3-6, 6-20, A-2

M

metal-clad, 3-7
motor, 1-4, 3-2, 4-2, 6-20, 6-26, 6-29, A-4, A-6

connections, 2-5, 3-1, 3-2, 3-10
ground brush, 4-2
tachometer, 4-2

mounting requirements, 2-1, 2-4, 2-7, 3-7, 4-1
airflow, 2-4, 2-8–2-12, 2-14, 2-16
clearance, 2-2, 2-4, B-3
dimensions, 2-4, 2-7, A-4
heat loss, 2-4, 2-8
layout, 2-1, 3-1, 3-3, 6-2, A-3, A-4
weight, 2-2, 2-4, A-4

N

non-regenerative source, 1-4, 2-9, 2-16
line filter, 4-4–4-6

O

outline, 1-5, 2-1, 2-4, A-1, A-4
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Index—continued

P

parameters, E-9, E-11, E-18–E-19, E-23, E-25, E-27
pattern, 1-4, 6-2, 6-8, 6-11–6-13, 6-22, E-3, E-7, E-10,

E-19, E-22, E-30
.icb, 6-10–6-11, 6-13, 6-20, 6-25, E-2, E-7, E-9
ACCBN-A, 1-4, 1-5
ACDCF-G, 1-4, 1-5
ACDCF-S, 1-4, 1-5
ACDCF-V, 1-4, 1-5
flash, 6-11, 6-13, E-16, E-22

power, 1-4, 2-4, 3-1, 3-4, 3-5, 3-7, 3-8, 4-1, 4-3–4-5
ac input, 4-3
cabling, 1-5, 3-1, 3-2, 3-7, 3-9, 3-10
connections, 2-5, 3-1, 3-2, 3-10
LEDs, 6-6–6-8
line filter, 4-4–4-6
reactor line, 3-2, 3-4, 4-3, 4-6, 4-7
transformer, 3-4, 3-6, 3-7, 4-3, 4-5, 4-6

power bridge, 6-6
preventive maintenance, 4-2
processor, 6-7, 6-20, E-10

R

reactor
ALSA, 4-3

reactor, line, 3-2, 3-4, 4-3, 4-6–4-7
regenerative source, 2-9, 2-11
renewal parts, 1-5
requisition, 1-5, 2-1, 2-3–2-4, 3-4, 3-6, A-1–A-4, A-2,

A-3–A-5
reset, 6-17–6-18, 6-21, E-16, E-23

S

safety ground, 6-26
shields, 3-6
simulator, 6-25–6-26
source, 1-4, 2-9, 4-4–4-6, 6-2

non-regenerative
reactor, line, 3-2, 3-4, 4-3, 4-6–4-7

storage, 1-1, 1-5, 2-1
Summary View, 6-12, E-24

T

tachometer, 4-2
terminal board, 3-1, 3-2, 3-6, A-4
toobox
toolbox, 1-1, 6-2, 6-8, 6-9, 6-15, 6-18, 6-19, 6-27, E-1,

E-2, E-5, E-10, E-11, E-21, E-23, E-29
autotune, 6-17
configuration, 3-4, 3-7, 3-8, 6-6, 6-8, 6-10, 6-11, A-5,

E-5, E-9–E-11, E-19
Control System Solutions, 6-9, 6-11, 6-13, 6-27
help, 1-2, 3-7, 6-3, 6-8, 6-28, E-10, E-17
Summary View, 6-12, E-24
Trend Recorder, 6-27, 6-28, E-14, E-27
wizards, 6-8, 6-17, 6-20, 6-22, 6-24–6-25, 6-29,

 E-13, E-30
cell test, 6-20, 6-26–6-27

torque, 2-5
transformer, 3-4, 3-6, 3-7, 4-3, 4-5, 4-6
Trend Recorder, 6-27, 6-28, E-14, E-27

help, 1-2, 3-7, 6-3, 6-8, 6-28, E-10, E-17
tuneup, 6-1, 6-20, 6-29

U

unpacking, 2-3

W

weight, 2-2, 2-4, A-4
wizards, 6-8, 6-17, 6-20, 6-22, 6-24–6-25, 6-29, E-13,

E-30
autotune, 6-17
cell test, 6-20, 6-26–6-27
tuneup, 6-1, 6-20, 6-29
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Notes
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<RXU�1DPH 7RGD\¶V�'DWH

<RXU�&RPSDQ\¶V�1DPH�DQG�$GGUHVV -RE�6LWH

*(�5HTXLVLWLRQ�1R�

3XEOLFDWLRQ�1R�<RXU�-RE�)XQFWLRQ���+RZ�<RX�8VH�7KLV�3XEOLFDWLRQ

3XEOLFDWLRQ�,VVXH�5HYLVLRQ�'DWH

,I�QHHGHG��KRZ�FDQ�ZH�FRQWDFW�\RX"

)D[�1R�

3KRQH�1R�

(�PDLO

$GGUHVV

*HQHUDO�5DWLQJ
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